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ABSTRAKT

Tato bakalarska praca sa venuje vytvoreniu laboratérnej Glohy zaradenej do predmetu
Komunikacni systémy pro loT. Prvii Cast prace tvori zozndmenie sa s problematikou IQRF
siete, jej topoldgiou a moznostami siete. V praci je porovnana IQRF technolégia s dalsimi
loT technoldgiami, ktoré st Casto pouzivané v tomto odvetvi. Praktick( Cast prace tvori
samotny navrh modulu pre IQRF vysiela¢ TR-72DA v tvare mini PCle karty. DalSia ¢ast
prace sa zaoberd vytvorenim komunikacie s BPC-loT doskou pomocou zbernice SPI.
Ako priklad sa vyuZiva meranie teploty. Poslednou Castou prace je zadanie pre samotnl
laboratérnu Glohu. Prilohy obsahuji aj schémy a zdrojovy kéd programov BPC-loT dosky
aj IQRF vysielaca.

KLUCOVE SLOVA

Internet veci, IQRF, LoRa, ZigBee, mesh, gateway, IQMESH protokol, uzol, oneskorenie,
payload, prenosova rychlost, dosah siete, vysielac, siet, 12C, UART, SPI, mini PCle, M2
key E, TR-72D

ABSTRACT

This bachelor’s thesis deals with creating a laboratory task integrated into the subject
of "Communication Systems for loT." The first part of the thesis consists of familiarizing
oneself with the issues of the IQRF network, its topology, and the network's capabilities.
The thesis compares IQRF technology with other loT technologies commonly used in this
field. The practical part of the thesis comprises the design of a module for the IQRF
transmitter TR-72DA in the form of a mini PCle card. Another part of the thesis deals
with establishing communication with the BPC-loT board using the SPI bus, with tem-
perature measurement used as an example. The final part of the thesis is the assignment
for the actual laboratory task. The appendices also include schematics and source code
of programs for both the BPC-loT board and the IQRF transmitter.
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tency, payload, data rate, network range, transmitter, network, 12C, UART, SPI, mini
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Uvod

Aktudlne st casto uplatnované v beznom zivote inteligentné technolégie, smart
mesta ¢i budovy, v ktorych sa vyuzivaju instalacie ako napriklad inteligentné par-
kovanie, osvetlenie ¢i monitoring odpadového hospodarstva. Tieto instalacie tvoria
velky celok nazyvany Internet veci. Siet internetu veci sa sklada z viacerych zariadeni
ako s senzory s dlhou vydrzou pri batériovom napajani, centralne prvky - gateway,
ktoré spajaju siet senzorov a internetové tlozisko (cloud). Bez tychto zariadeni by
internet veci nemohol fungovat. V oblasti vyvoja prvkov do internetu veci sa uz spe-
cializuje mnoho firiem a jednou z nich je aj IQRF Tech s.r.o. v Ji¢ine, ktord vyvija
technolégiu IQRF. IQRF je bezdrotova technoldgia stredného dosahu s paketovou
orientaciou, dlhou zivotnostou a beztudrzbovostou.

Cielom tejto bakalarskej prace je zadefinovat teoreticky zaklad a vytvorit prak-
tické podklady pre laboratérnu tlohu IQRF modul pre meranie mesh sieti.

Prvou castou bakalarskej prace je teoreticky rozbor zédkladnych vlastnosti a pa-
rametrov IQRF technolégie, ktoré st nasledne v druhej kapitole porovnané s inymi,
frekventovane pozivanymi technolégiami pre internet veci.

Pre spojenie IQRF vysielaca a BPC-IOT dosky, ktora bude napajat a komuni-
kovat s IQRF vysielacom a vykonavat merania IQRF siete, je potrebné navrhnut
modul. Tento modul bude navrhnuty pre mini PCle kartu pouzitim névrhového
softvéru Altium Designer a nésledne vyrobeny firmou JLC PCB a rucne osadeny
siuciastkami. Do modulu bude osadeny aj IQRF vysiela¢ naprogramovany v jazyku
C. Modul s vysielacom bude vsunuty do mini PCle slotu na BPC-IoT doske na-
programovanej v jazyku microPython. IQRF vysiela¢ bude posielat snimané tdaje
na koordinator.

Laboratérna tloha sa nachddza v prilohe A, anglicka verzia tejto tlohy je v pri-
lohe B, schéma, navrh dosky a stubory pre vyrobu modulu v prevedeni mini PCle

karty v prilohe C, D a E. Zdrojové kédy k jednotlivym zariadeniam st v prilohe F.
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1 IQRF technolégia a jej zakladné znaky

Internet veci (Internet of Things - IoT) je koncept, ktory ma snahu prepojit veci
z bezného zivota s internetom pomocou senzorov a softvérov, ktoré si takmer bez-
udrzbové a maju nizku spotrebu elektrickej energie. V stcasnosti sa na sféru IoT
rieSeni Specializuje mnoho firiem, ktoré vyvijaju technoldgie s roznym sposobom
a dosahom pokrytia oblasti. Medzi tieto technologie patri aj platforma IQRF.

1.1 Uvod do IQRF

IQRF (Intelligent Quick Response Frequency) je bezdrotova technologia a platforma
pre IoT orientovana paketovo. Umozinuje posielat nizke mnozstvo dat s minimalnou
spotrebou elektrickej energie a maximéalnou spolahlivostou. Technoldgia je vhodna
pre narocné aplikacie, ktoré si vyzaduju ¢o najnizsiu spotrebu elektrickej energie
ako st batériou napdjané instaldcie, aplikacie pre IoT, Smart Cities (Inteligentné
mestd). IQRF technoldgia bola vyvinuta v roku 2004 ceskou firmou MICRORISC
a v roku 2017 bola zalozena jej sesterska spolocnost IQRF Tech s.r.o. v Ji¢ine,
ktora sa zaobera vyvojom IQRF technolégie a jej zariadeni az do dnes a je hlavnym

koordinatorom IQRF technoldgie vo svete [1], [2].

1.2 Zakladné parametre IQRF

IQRF technolégia pracuje v nelicencovanom Sub-GHz ISM (industrial scientific me-
dical) radiovom péasme (433, 868, 915 MHz) v zavislosti od kontinentu alebo statu
instaldcie. V. Ceskej republike je pouzivané 868 MHz pasmo. IQRF nepotrebuje
externi infrastruktiru ako si mikrovinné prepojenia alebo dlhé kablové vedenia.
Moduly IQRF technolégie mozu pracovat v réznych typoldgiach ako napr. bod -
bod, hviezda, ale najcastejsie je pouzivana v mesh topoldgii obr.1.1. Pévodne bola
technologia IQRF vyuzivand v automatizacii budov, ale v poslednych rokoch tech-
kaciach. Na obr.1.1 je znazorneny typicky dizajn IQRF siete obsahujuci jednotlivé
uzly (senzory) v mesh topologii, gateway, cloud a pripojenie na internet (aplikacia

pre komunikaciu so svetom) [2], [3], [4], [5].
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IQRF MESH SIET

GATEWAY APLIKACIA

Obr. 1.1: Dizajn IQRF siete

1.3 IQREF siet

Technoldogia IQRF je dizajnovand do meshovej topologie (IQMESH). Pri pouziti
topoldgie mesh je vyuzity smerovaci mechanizmus, ktory dokaze odstranit nevy-
hody topoldgie hviezda a zvysit tak spolahlivost celej siete. Zakladnym prvkom
siete je IQRF vysiela¢ (transciever) tvoreny malym modulom pouzivanym k prenosu
dat. Vysiela¢ obsahuje mali mikrokontrolérovi 8-bitovi jednotku (MCU) operujicu
so vstavanym operacnym systémom (OS) riadiacim prenos dat.

Jednotlivé funkcie pristupu st do IQRF vysielaca zadané dvoma moznymi spo-

sobmi:

e Prvy sposob je zadany pomocou uzivatelskej aplikacnej vrstvy pouzivajicej
preddefinované funkcie v OS. Funkcie je mozné naprogramovat v programova-
com jazyku C, avsSak tato moznost nie je podporovana sietami IQMESH.

e Druhy sposob je zalozeny na trojvrstvovej IQRF architekttre s hardvérovym
profilom, ktory je schopny pouzivat softvérovy aplikacny plug-in. Vsetky zdroje
a sluzby moézu byt pristupné cez hardvérovy profil. Hardvérovy profil v realite
implementuje periférny pristup k zariadeniu nad OS.

Z uvedeného vyplyva, zZe programovanie nie je potrebné a funkcionalita je dosiahnuta
jednoducho riadenim cez datovy tok.

Z tohto dovodu je mozné pouzit dva rozne radiofrekvencné komunikacné rezimy:

e Siefovy - obsahujuci jeden koordinacny uzol spravujici meshovi siet zlozenu
az z 239 uzlov pre jednu sief. V takejto sieti s datové pakety pristupné len pre
tie uzly, ktorym st adresované. Kazdy uzol preto vie slizit ako koordinator
alebo spolo¢ny uzol. Takto moze v jednej sieti byt pripojenych az 65.000 pra-
covnych uzlov, ktoré vedia na pozadi pracovat ako smerovace. Vdaka tomu je
podporovanych az 240 hopov na jeden paket. Cesta pre paket moze byt najdena
a vytvorena automaticky ako smerovacia struktira s moznostou vyhladavania
trasy. Trasy su vytvorené automaticky cez redundantné cesty v mesh sieti.

o Nesietovy - nepodporuje sietové funkcie, je vhodny pre aplikaciu zhotovenu
z malého mnozstva zariadeni peer-to-peer komunikaciou. Pri maximalnom

moznom rozsahu st datové pakety pristupné pre vsetky zariadenia [2], [3], [6], [7].
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1.4 1QRF Gateway

Nad IQRF siefou a jej uzlami moze prevziat kontrolu cloudovy server. V takom
pripade je potrebné pouzit v sieti branu (gateway). Gateway poskytuje rozhranie
pre spojenie a komunikaciu medzi IQRF siefou a a ostatnymi siefami podporujtcimi
internetovi konektivitu. IQRF aliancia zatial vyvinula Wi-Fi, GSM a ethernetové
gateway. Kazdy gateway obsahuje senzor - uzol, ktory slizi ako koordinator pre os-
tatné uzly v sieti. Gateway potom umoznuje zber dat, pristup a kontrolu ostatnych
zariadeni. IQRF gateway vie byt implementovany z Linuxovych zariadeni ako na-
priklad Raspberry Pi. Okrem toho st podporované aj zariadenia bez operac¢ného

systému ako napr. Arduino... 2], [3].

Gateway
'V'_es%h Cloud
Sie Raspberry Pi, :
Arduino, -
E TN G -

Obr. 1.2: Gateway v réznych prevedeniach

1.5 IQRF Cloud

IQRF cloud je server, ktory poskytuje okamzitti sluzbu spojenia medzi pouzivatelmi
a siefou IQRF s pouzitim klient-server komunikacie. Zaroven sa na tomto serveri vy-
tvara tlozisko udajov, ktoré si dostupné aj po urcitom case v zavislosti od kapacity
paméte servera. Data sa odosli zo senzoru na gateway a odtial st priamo nahraté
na server. Takto ulozené data si uz dostupné priamo cez internetovy prehliadac

alebo pomocou aplikacie [3].

1.6 IQMESH protokol

IQMESH (Inteligent Mesh) je patentovany meshovy komunikaény protokol pouzi-
vany vramci ekosystému technologie IQRF. Je navrhnuty na sprostredkovanie bez-
drotovej komunikacie v mesh topolégii, v ktorej kazdé zariadenie méze komunikovat
s okolitymi zariadeniami a potencidlne sluzit ako preposielaci uzol na rozsirenie do-
sahu siete. Kazdy paket je smerovany uzlami na pozadi neobmedzujtc ich funkciona-

litu. Tento proces je riadeny operacnym systémom a je nebadatelny pre uzivatela.
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IQMESH podporuje viaceré smerovacie struktiry ako si: aplny mesh, redukovany
mesh, optimalizovany mesh, strom... Smerovanie moze prebiehat staticky, a taktiez
moze byt pod uplnou kontrolou uzivatela. Dynamické ¢asovanie s vyberom poctu
krokov v sieti a volitelnym casovym tisekom umoznuje maximalnu priepustnost s mi-
nimalnym rusenim a spotrebou elektrickej energie. Efektivita a spolahlivost je do-
siahnuta pomocou takzvaného zaplavového mechanizmu, ktory funguje podobne ako
povoden - informécia je na miesto dorucenia posland viacerymi moznymi cestami
- podobne ako voda pri povodni zaplavuje miesta kadial moze pretiect. Koliziam
v sieti sa predchadza pomocou systému Time Division Multiple Access, ¢o v pre-
klade znamend viacnasobny pristup s casovym delenim. Aj napriek vysSie spome-
nutym vyspelym funkcionalitam je IQMESH implementovatelny do jednoduchého
a lacného zariadenia s limitovanymi moznostami.

Kazdé zariadenie v sieti ma unikatne ¢islo - logickt adresu priradentd pri vyrobe.
Smerovaci algoritmus Discovered Full Mesh (objavovaci plne meshovy algoritmus)
vyuziva virtualnu smerovaciu struktiru, ktora vznika pri procese objavovania, kedy
koordinator prideli virtualne smerovacie ¢islo do kazdého zariadenia, ktoré dokaze
smerovat. Na obr.1.3 je v lavej casti zobrazena Standardné staticka siet, v ktorej
st uzly adresované pomocou logickej adresy - N1, N2, ..., Ni. Na pravej strane je
pridana virtudlna struktira (oranzovo znézornené zény). Zény si vytvarané zo za-
riadeni s rovnakym poc¢tom potrebnych hopov na pristup do koordinatora. Nasledne
st v zonach pridelené virtudlne smerovacie ¢isla. Logicka adresa je pouzivana pre de-
finovanie cielového zariadenia a virtualne smerovacie ¢islo je pouzivané OS pre sme-
rovanie. Virtudlne smerovacie ¢islo je pridelované systematicky podla vzdialenosti
uzla od koordinatora, ¢o ulahcuje pracu zaplavovému algoritmu a taktiez aj inym
smerovacim algoritmom. Mozné je tiez smerovanie pomocou logickej adresy, pretoze
uzly mozu byt ulozené v poradi podla logickej adresy. V kombinécii s protizrazkovym
mechanizmom je vytvoreny smerovaci, efektivny a bezkolizny prenos.

Pocas vyhladavania koordinator hlada uzly pripojené k sieti, aby im bol schopny
pridelit unikatne virtualne smerovacie ¢islo. Koordinator zahdji proces vyhladava-
nia a vsSetky zariadenia, ktoré odpovedaji na vyzvu koordinatora ,, Odpovedzte mi‘
ich dostant pridelené. Na zaklade prijatej odpovede a za predpokladu, ze prepoje-
nie medzi uzlami a koordinatorom bolo symetrické, sii objavené smerovacie cesty
do uzlov a naspat ku koordinatorovi. Vsetky uzly majice priame spojenie s koor-
dindtorom patria do Zény 0 a su dostupné bez smerovania. Koordinator postupne
vytvara zony so stipajicim poradovym ¢islom. Tieto zény si vytvarané tak, ze vset-
kym uzlom z aktudlnej zény je prikazané, aby nasli svojich susedov so vzdialenostou
1 hop. Tento algoritmus sa opakuje pokial nie je dosiahnuta zona, ktora uz nema
koho objavovat. Tato zéna sa nazyva okrajova a vsSetky ostatné zény tvoria Rou-

ting Backbone (smerovaciu chrbticu). Takyto proces objavovania sa pri aplikacidch
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inteligentnych budov ¢i miest vykonava iba pocas budovania siete, nakolko pri ta-
komto type siete nenastavaji Casté zmeny v sieti. Ak by nastali, musel by proces
objavovania prebehnit opatovne.

Na rozdiel od inych technolégii IQRF nepotrebuje zdielat napriec¢ siefou detailni
informaciu o ¢ase. Smerované pakety sleduju pocet uskutocénenych hopov, ¢o zod-
poveda prislusnej zéne a c¢asovému useku na zdklade virtualneho smerovacieho cisla.
Spatné poradie sa zase vyuziva na preposielanie odpovedi z uzlov spaf na koordi-
nétor. Tento mechanizmus s pridanim informécie o dizke ¢asového okna vytvdra
efektivnu synchronizaciu vsetkych zariadeni. Podporovany je aj iny sposob synchro-

nizécie a to dynamické ¢asovanie zalozené na dlzke paketu [2], [8], [9], [10], [11].

&3 ey
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Obr. 1.3: Logické adresy a virtualne smerovacie ¢isla po objavovani
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1.7 Latencia - Oneskorenie

Dolezitym parametrom pre kazdu siet je jej oneskorenie pri smerovani. Tento para-
meter siete je rozdielny podla preferencii danej insStalacie. Oneskorenie je odlisné
ak je preferovand nizka troven oneskorenia s oznacenim STD (Standard) alebo
nizka spotreba energie znac¢end LP (Low Power). Pri STD je oneskorenie do 60 ms
a pri LP je oneskorenie o nieco vyssie - do 100 ms. Tieto mody s roznym oneskorenim
je mozné aj kombinovat (STD+LP). Podla pomeru ich kombinécie vznikd unikétna
hodnota oneskorenia z vyssie uvedeného intervalu 60 ms - 100 ms. STD+LP je
najcastejsie pouzivanym médom v IQRF sieti, pretoze tento méd umoznuje pouzi-

vatelom najidedlnejsie nastavenia siete pre ich konkrétne vyuzitie [10], [7].

1.8 Prenosova rychlost a payload

Data, ktoré zozbiera senzor v IoT sieti, nie st velkého rozsahu. Pri prenasani dat
70 senzorov preto nie je potrebné dosahovat vysoki prenosovi rychlost. Prenosova

rychlost technolégie IQRF je zdanlivo nizka. V zavislosti od pouzitia konkrétneho
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IQRF modulu sa prenosova rychlost pohybuje okolo 19 az 20 kbps. Téato rychlost je
dostatocna pre aplikacie, ktoré preferuji parametre ako je vyssi dosah siete alebo
nizsia spotreba elektrickej energie. Maximalna prenosova rychlost siete méze byt tak-
tiez ovplyvnena konkrétnym prostredim instalacie alebo nastavenim prvkov v sieti.
V oblastiach s vysokym rusenim je prenosova rychlost nizsia ako v oblastiach s niz-
kym zarusenim pasma. To isté plati aj pre payload, ktory pri idealnych podmienkach
dosahuje velkost spravy 64 bytov [4], [12].

1.9 Dosah siete IQRF

Maximalny dosah jedného IQRF vysielaca je certifikovany na 500 m volného pries-
transtva, ¢o pri pouziti viac ako 200 zariadeni v mesh topolégii predstavuje rozlohu
az desiatky kilometrov stvorcovych. Z tohto dévodu IQRF siet radime do kategorie
WMAN (Wireless Metropolitan Area Network) obr. 1.4, kde je tento dosah zobra-
zeny v porovnany aj s dosahmi inych IoT sieti. Pri redlnej aplikécii s prekazkami sa
dosah rapidne znizuje a je potrebné prepojit viacero IQRF sieti pomocou stredového
prvku ako, je to zobrazené na obr.1.5 [4], [13].

WPAN

Q Wi-Fi, Bluetooth, ZigBee

() Wireless M-Bus, Wi-Fi {2 {2 1aRF) LoRa, SigFox

()
—/

—

«——10- 100 m——————>

< 100 - 1000 m—

< 1-10 km—>

< 10 - 100 km—>'

Obr. 1.4: Porovnanie dosahu viacerych sieti z IoT odvetvia
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Obr. 1.5: ZlicCenie dvoch sieti

1.10 Spotreba elektrickej energie

IQRF zariadenia vedia pracovat v roznych stavoch vzhladom na spotrebu elektrickej
energie. Pri spravnom pouziti a skombinovani jednotlivych stavov vieme dosiahnut
tak nizku spotrebu, Ze zariadenia nadobudni mnohoro¢ni vydrz na AAA batérii.
Pre lepsiu predstavu technologia obsahuje tri zdkladné stavy:
» Vysielanie, kde v zavislosti na nastavenom vykone dosahuje najvyssi potrebny
napajaci prad 19 mA,
o Prijimanie, kde maximalny odoberany prud je priblizne 12 mA,
e Rezim spanku, ktory dokaze spotrebu zariadenia tplne minimalizovat az
na hodnoty mensie ako 1 pA a pri hlbokom spanku az na hodnoty mensie
ako 1 nA [14].

Viac rezimov s detailnejsimi popisom o spotrebe sa nachadza v tab.1.1

Modul TR-76D
Stav IQRF zariadenia Odber elektrickej energie

Vysielanie s maximalnym vykonom 19 mA
Vysielanie s minimalnym vykonom 8,4 mA
MCU bezi a RF vypnuté 1,53 - 71,67 mA
MCU bezi a RF dsporny rezim 2,83 mA
Nizko energetické vysielanie LP 244 nA
Prijimanie s maximalnou tsporou XLP 15 pA
Prijimanie s nizkou latenciou STD 11,9 mA
Rezim spanku >1 pA
Hlboky spankovy rezim >100 nA

Tab. 1.1: Spotreba elektrickej energie konkrétneho IQRF modulu
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1.11 Bezpecnost IQRF siete

Kazda prenasana informacia moze byt pre niekoho cennd alebo citliva, preto je
dolezité, aby IQRF siet mala dobrii ochranu pred itokmi alebo poskodenim s ciefom
dostat sa ku prenasanym informéaciam.

Poskodenie koncovych uzlov je jednym z najcastejsich a najskodlivejsich itokov
na bezdrdtovu siet so senzormi (WSN - wireless sensor network). Je to spdsobené
tym, Ze pri takejto sieti su uzly pritomné takmer vsade (Tahko pristupné miesta
bez ochrany) a maji obmedzenia v tloznych a aj vypoctovych oblastiach. Utoénik
teda moze sief odpocivat bez akychkolvek priamych prekazok. Kazdy takyto ttok
zacieleny na koncové uzly méze sposobit zlyhanie v sieti.

Poskodenie koordinatora je dalsim castym spdsobom titoku na sief, kedze kazda
informécia z koncovych uzlov prechadza prave tymto bodom. Koordinator taktiez
zohréva hlavna tlohu pri pripojeni koncovych bodov (senzorov) na gateway a na-
sledne na internet.

NajcastejsSim tercom hekerov je gateway, pretoze vsetky prenasané informaécie
z IQRF siete nou prechadzaju. Hekeri iitokom informécie ukradnt alebo ich zablo-
kuju.

Bezdrotova komunikacia ¢i cely systém je vystaveny potencidlnemu ttoku vzdu-
chom OTA (over-the-air). Z tohto dévodu sa od verzie operac¢ného systému 4.0 IQRF
aliancia zamerala najmé na bezpecnost siete. Od tejto verzie je v IQRF operacnom
systéme implementovana ochrana zalozend na priemyselnych standardoch a zais-
tuje tak autorizovany pristup k toku dat vzduchom. Konkrétne bol v operacnom
systéme implementovany standard AES-128 pre Sifrovanie bezdrotovej komunikéacie.
Okrem sifrovania dat sa zvysuje aj celkova ochrana siete a zabranuje sa falSovaniu
jednotlivych paketov.

V IQRF sieti existuju tri hlavné tirovne ochrany, ktoré su zalozené na sifrovani
AES-128:

« Sifrovanie pristupu: toto nezavislé Sifrovanie sa vizdy pouziva pri pripajani
vsetkych zariadeni k sieti. Tato troven ochrany zabezpecuje, ze k sieti majua
pristup len autorizované zariadenia a teda chrani siet pred neautorizovanym
pridavanim uzlov do siete. Ked sa zariadenie pokusi pripojit k sieti, pristupové
sifrovanie pomaha overif jeho autenticitu a autorizaciu.

« Sifrovanie komunikicie v sieti: je to bezpetnostns vrstva, ktord pouziva
sifrovanie na vsetky komunikacie v IQRF sieti. Tym je zabezpecené, ze idaje
prenasané medzi jednotlivymi zariadeniami v sieti st bezpeéné a nemézu byt
jednoducho odchytené alebo poskodené neautorizovanymi stranami. Sifrova-
nie siete poméaha chranit integritu a dovernost tidajov vymienanymi medzi

zariadeniami v sieti.
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« Sifrovanie pouzivatela: poskytuje dodatoénii iroveri bezpenosti umoziiujic
sifrovanie udajovych paketov (payload) pomocou pouzivatelom definovaného
klca v aplikacnom kode pouzivatela. Toto Sifrovanie je volitelné a moze byt
implementované na skrytie obsahu vybranych tdajovych paketov. Umoznuje
pouzivatelom kontrolu nad sifrovanim konkrétnych tdajov a poskytuje doda-

toénu drovelnl bezpecnosti pre citlivé informacie [10], [15], [16], [17].

1.12 Zhrnutie parametrov IQRF siete

V tabulke 1.2 st spisané najdolezitejsie parametre IQRF siete. Tieto parametre si
vseobecné a teda mozu sa odliSovat v zavislosti od pouzitych zariadeni alebo apli-
kovanych nastaveni pre jednotlivé zariadenia napr. nastavenie vysielacieho vykonu

alebo oneskorenia pre dany vysiela¢ ¢i uzol.

IQRF
Velic¢ina Jednotka Hodnota
Pracovna frekvencia MHz 433, 868, 916
Prenosova rychlost kbps 20
Max. dlzka prendSanej spravy byte 64
Max. dosah vo volnom priestranstve m 1000
Modulacia - GFSK
Topologia - mesh
Oneskorenie ms 60 - 100
Max. pocet uzlov na gateway - 65*103
Teoreticky cas zivota na AAA batérii rok 5-10

Tab. 1.2: Prehlad parametrov IQRF siete
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2 Dalsie riesenia loT sieti

V 10T aplikaciach sa pouzivaju okrem IQRF platformy dalsie podobné technolégie.
Pre porovnanie si v praci pouzité technologie s podobnymi parametrami ZigBee,
Bluetooth Low Energy a Wi-Fi Hal.ow. Taktiez zaujimava je aj primarne tplne

odlisna siet akou je LoRa, ktora vsak uz vie pracovat v mesh topologii.

2.1 LoRa

LoRa je technoldgia vyvinuta firmou Semtech a Microchip, ktord mé patentovany
pristupovy a kontrolny protokol LoRaWAN. Vyhody technolégie LoRa st pozna-
telné uz v nazve LoRa - Long Range - v preklade do slovenc¢iny dlhy dosah. Dosah
technolégie LoRa je od 5 do 20 km na jeden gateway v zavislosti od prostredia
v akom sa vysiela. LoRa vyuziva topoldgie typu hviezda, v ktorej je centralny prvok
zaroven pouzivany ako gateway. Pouzita topoldgia umoznuje pouzitie vacsieho mnoz-
stva senzorov (uzlov) na jeden gateway. Nevyhody siete LoRa vyplyvaji z pouzitej
topolodgie. Pri poruche centralneho prvku sa celd siet stava nefunkénou. Dorucenie
sprav pri hviezdicovej topologii je taktiez menej spolahlivé ako pri doruceni sprav
pri topoldgii mesh. Z tohto dovodu prisla LoRa aliancia s inovaciou a to pouzitim
mesh topoldgie alebo kombinovanej topologie mesh a hviezda.

LoRa ako bezdrdtova siet vyuziva Direct Sequence Spread Spektrum (DSSS)
na fyzickej vrstve, ¢o umoznuje vysielat s vyuzitim nizsieho vysielacieho vykonu
pre signal. Pouzitim FSK (Frequency Fhift Keying) modulacie sa meni frekvencia
pre nosné vlny podla toho, aky bit vstupuje do modulécie (0 alebo 1) zo signalu,
ktory sa prave moduluje. LoRa je schopna demodulovat a rozoznaft signaly, ktoré s
niekolko desiatok decibelov pod troviiou Sumu. Toto je mozné vdaka FEC (Forward
Error Correction) mechanizmu, ktory odoslanim paritnych paketov v pripade po-
treby opravi strateny alebo poskodeny datovy tok. Jeden paritny paket je vysielany
pre skupinu N paketov.

LoRa pracuje v nelicencovanom sub GHz pasme rovnako ako IQRF ¢o v Eurdpe
predstavuje 863 - 870 MHz. Data prenasa rychlostou 0,25 az 50 kbps. Velkost spravy
v technoldgii LoRa moze byt z rozsahu 2 az 255 bajtov [18].
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LoRa
Velic¢ina Jednotka Hodnota
Pracovna frekvencia MHz 443, 868, 780, 915
Prenosova rychlost kbps 0,3 - 40
Max. dizka prendsanej spravy byte 243
Max. dosah vo volnom priestranstve km 15
Modulacia - CSS
Topologia - hviezda, mesh
Oneskorenie ms >1000
Max. pocet uzlov na gateway - 104
Teoreticky cas zivota na AAA batérii rok 5-10

Tab. 2.1: Prehlad parametrov technolégie LoRa

2.2 ZigBee

ZigBee je taktiez technologia pre bezdrotovi komunikaciu s kratsim dosahom po-
dobne ako IQRF. Vyuziva 2,4 GHz pasmo. ZigBee je velmi spolahliva technologia,
kedze vo svojej architektiire implementuje zasady ako tito spolahlivost dosiahnuf.

Prvym bodom spolahlivosti je implementacia standardu IEEE 802.15.4 pre siete
s kratsim dosahom, ale vysokou spolahlivostou. Zakladom tohto standardu je mo-
duldcia OQPSK (Offset Quadranture Phase Shift Keying) a DSSS (Direct Sequence
Spread Spectrum), ktorych kombinacia dosahuje vynikajice vysledky v prostrediach
s velmi nizkym odstupom signalu od sumu.

Druhym bodom je pouzivanie CSMA-CA (Carrier Sense Multiple Access Collie-
sion Avoidence) metédy. ZigBee najskor pred vysielanim naslicha kandlu a az ak
kanal je volny, vysielanie moze zacat. Tato metoda zabranuje dvom zariadeniam
v sieti vysielat naraz a tak zabranuje znehodnoteniu dat.

Treti bod spolahlivosti je pouzivanie 16 bitového CRC (Cyclic Redundancy
Check) na kazdom pakete, ¢o ma za néasledok kontrolu spravnosti datovych bitov.
Kazdy paket ma Styri moznosti opatovného odoslania. Ak sa ani na Stvrty krat
nepodari paket dorucit, odosielaci uzol je informovany o probléme a je na nom,
aby vyhladal novi cestu na dorucenie. V pripade ak sa nova cesta vyhladat neda,
odosielaci uzol je informovany, aby paket uz nebol viacej posielany.

Posledny bod spolahlivosti, ktory je pouzivany technoldgiou ZigBee, je samotna
topologia mesh, v ktorej ZigBee pracuje. Tato topologia zvysuje svoj dosah a spo-
lahlivost pomocou viackrokového posielania paketov. Robustnost siete je zvysena
tak, ze ak je nejaka cesta v sieti zahltena alebo poskodend, vyhlada sa nova cesta

cez iné dostupné uzly.
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Vysielanie v 2,4 GHz pasme podla standardu IEEE 802.15.4. je mozné az s preno-
sovou rychlostou 250 kbps. Avsak po zopakovani Sifrovania a desifrovania a po plnom
vyuziti mesh protokolu, priepustnost siete je skor okolo 25 kbps. Vysielace vyuzivaju
poloviéne duplexné spojenie, ¢o znamena, ze rovnakou cestou je realizované aj vy-
sielanie aj prijimanie, avSak obe funkcie nevedia byt realizované zaroven. Tato sku-
tocnost ma taktiez za nasledok znizenie prenosovej rychlosti z 250 kbps na 25 kbps.
V sucasnosti je dostupny Standard IEEE 802.15.4b. Ak by si ZigBee osvojilo tento
standard, prenosova rychlost by mohla stipnut na 40 kbps.

Spotreba elektrickej energie zariadeniami v sieti je velmi nizka, ¢o je vyhodné
pri napédjani zariadeni batériou, pretoze pri vydrzi batérii niekolkych rokov je prak-
ticky tudrzba takéhoto zariadenia takmer nepotrebna. Nizku spotrebu elektrickej
energie znasobuje aj to, ze Zigbee zariadenia vyuzivaju podobne ako IQRF rozne
rezimy v zavislosti na spotrebe. Taktiez komunikéacia medzi zariadeniami neprebieha
neustale, ale len v urcitych casovych intervaloch.

ZigBee je nie len spolahliva technolégia, ale aj bezpecna, kedze implementuje
standard bezpecnosti AES-128 (Advanced Encryption Standard). Tento Standard
Sifruje pakety spdsobom, ktory je velmi narocné prelomit. Standard AES je pova-
zovany za jeden z najlepsich bezpecnostnych standardov, zabezpecuje aj sifrovanie

paketov aj autorizaciu uzlov [19].

ZigBee
Velic¢ina Jednotka Hodnota
Pracovna frekvencia GHz 2,4
Prenosova rychlost kbps 250
Max. dizka prendsanej spravy byte 128
Max. dosah vo volnom priestranstve m 300
Modulacia - BPSK, OQPSK
Topologia - hviezda, mesh, strom
Oneskorenie ms 16
Max. pocet uzlov na gateway - 65103
Teoreticky cas zivota na AAA batérii rok 2

Tab. 2.2: Prehlad parametrov technolégie ZigBee
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2.3 Bluetooth Low Energy

Bluetooth Low Energy (BLE) je bezdrotova technolégia s mensim dosahom. BLE
vyuziva 40 kanalov (37 je pouzitelnych pre prenos dat) v 2,4 GHz nelicencovanom
frekvenénom pasme. Tato technolégia umoznuje komunikaciu s nizkou spotrebou
elektrickej energie, ktord je mozna vdaka kratdim dizkam viny pouzitého radiového
signalu. BLE podporuje viacero komunikacnych topoldgii, poc¢inajic jednoduchym
point-to-point, broadcast, ale najcastejsie sa pouziva mesh. Tato topolégia umoz-
nuje, aby BLE bol schopny vytvorit pomerne velkii a stabilnt siet s vysokou re-
dundanciou. BLE poskytuje aj vyspelu lokalizac¢nu sluzbu pre vonkajsie podmienky,
teda vie presne zmerat a lokalizovat vzdialenost susediacich zariadeni a podla toho
ulahcif nastavenia pouzivatelovi. Podobne ako vyssie opisované IQRF aj BLE po-
uziva GFSK modulaciu. Nizku spotrebu elektrickej energie podporuje aj pomerne
nizky vysielaci vykon, ktory dosahuje maximalne hodnoty 100 mW. Takyto vysie-
laci vykon je vSak absolitne postacujtci, pretoze senzitivita prijimaca je menej ako

-70 dBm a v zavislosti od médu az menej ako -82 dBm [20].

Bluetooth Low Energy

Velic¢ina Jednotka | Hodnota
Pracovna frekvencia GHz 2,4
Prenosova rychlost kbps 2000
Max. dizka prendsanej spravy byte 251
Max. dosah vo volnom priestranstve m 400
Modulacia - GFSK
Topologia - mesh
Oneskorenie ms 6
Max. pocet uzlov na gateway - 65*103
Teoreticky cas zivota na AAA batérii rok 1-2

Tab. 2.3: Prehlad parametrov technolégie Bluetooth Low Energy

Obr.2.1 graficky znézornuje vyuzitie a rozdiely medzi technolégiou Bluetooth
a Bluetooth Low Energy. Vyhodou je, Ze novsie verzie smartfénov, tabletov ¢i note-

bookov podporuji uz obe tieto technolégie.
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Zariadenia
pre
komunikaciu

Bluetooth

vysoké prenosové rychlosti, nizke prenosové rychlosti,
video, audio, streamovanie maly obnos dat, nizka spotreba

Obr. 2.1: Bluetooth v porovnani s BLE

2.4 W.i-Fi HaLow

Wi-Fi Hal.ow je nazov pre nizko rychlostnt, asporni Wi-Fi s velkym dosahom. Tato
technolégia vyuziva licencované pasma s frekvenciou pod 1 GHz. V praxi to znamena
dlhsi dosah signalu a lepsiu priepustnost cez prekazky az do vzdialenosti 1 km.
Pri tychto vyuzivanych frekvenénych pasmach nie je potrebné vysielat s vysokym
vykonom, ¢o ma za nasledok zlepsenie uspory elektrickej energie. Wi-Fi HaLow

pracuje najcastejsie v mesh topoldgii [21].

Wi-Fi HaLow

Velic¢ina Jednotka | Hodnota
Pracovna frekvencia MHz 900
Prenosova rychlost kbps >150
Max. dlzka prendSanej spravy byte
Max. dosah vo volnom priestranstve km >1
Modulacia -
Topologia - mesh
Oneskorenie ms
Max. pocet uzlov na gateway - 8000+
Teoreticky cas zivota na AAA batérii rok

Tab. 2.4: Prehlad parametrov technolégie Wi-Fi HaLow

37



[bps]

100M Wi-Fi HaLow
10M | BLE
1M | ZigBee
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LoRa
10 100 1000 10000 [m]

Obr. 2.2: Pokles prenosovej rychlosti jednotlivych technolégii pre IoT v zavislosti

od vzdialenosti od vysielaca
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3 Navrh technického riesenia modulu pre vy-
sielac

Pre nasu pracu bol vybrany a pouzity IQRF vysiela¢c TR-72D, ktory sa na dosku
aplikuje pomocou konektoru pre SIM kartu. Pre pripojenie vyrabaného modulu st
dostupné dve zbernice M2 E-key a PCI-Express. Na tychto zberniciach je mozné
komunikovat a prendsat informécie pomocou viacerych protokolov SPI, UART a I2C.

Dostupné zbernice a protokoly st nizsie popisané a porovnané.

3.1 IQRF vysiela¢ TR-72D

V module je pouzity IQRF vysiela¢ TR-72D s integrovanou PCB (Pinted Circuit
Board) anténou priamo na doske. Tento vysiela¢ vysiela podla nastavenia na frek-
vencii 868 MHz alebo 916 MHz. Vysiela¢ je mozné vsunuf do konektoru na SIM
kartu, vdaka jeho malym rozmerom 31.8 mm x 14.9 mm x 3.3 mm (d x § x V).
Vyhodou tohto vysielaca je, ze obsahuje vstavany reguldtor napétia. Pre labora-
torne pouzitie ndm postacuje verzia s integrovanou PCB anténou, nakolko nie je
potrebné pokrytie rozsiahlych oblasti. Na obr. 3.1 je znazornena blokova schéma
tohto vysielaca [22], [23], [24].

¢ Y (MCU)

{RF [—

\ 4

O

A
2

\'— |OS|[—
EEPROMHe>
G
T )
Teplotny
P y =< | .. s
senzor Uzivatelskal | /6x /0, SPI, UART, I2C, [PWM,
aplikacia A/D, Komparator
)
3,1-53Vv| | Regulator 3%
“|napéatia LDO —_

Obr. 3.1: Blokova schéma vysielaca
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3.1.1 Technické parametre IQRF vysielac¢a TR-72D

Nizsie st uvedené technické parametre pouzitého vysielaca TR-72D, ktoré udava
vyrobca v technickom popise. Tieto parametre su dolezité pre spravnu volbu vysie-
laca pre danu instaldciu (napr. teplota okolia v mieste pouzitia vysielaca ...) a tak-

tiez pre tvorbu obvodu, v ktorom bude IQRF vysiela¢ pouzity (napr. napéjacie

napatie ...) [24].

Veli¢ina Jednotka | Hodnota
Napdjacie napatie \Y% 3.1az 5.3
Vystupné napétie \Y 3
Vystupny prud mA 60
Pracovna teplota °C -40 az +85
Odoberany prid pocas hlbokého spanku uA 1.7
Odoberany prud pocas spanku uA 2.3
RF spanok mA 1.95
RF pripraveny mA 2.8
RX STD mA 12.1
RX LP uA 260
RX XLP uA 18.5
TX mod mA 8.3 az 25
Spotreba LED na jednu diédu mA 2
RF pasmo pre Eurépu MHz 868
RF modulécia - GSFK
Maximaélna prenosova rychlost kbps 19.8
Efektivny vyzarovaci vykon Dbm 2
Dosah pokrytia (volné priestranstvo) m 500

Tab. 3.1: Technické parametre vysielaca TR-72D
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3.1.2 Vndtorné zapojenie TR-72D

Na obr. 3.2 je zndzornena schéma vnutorného zapojenia pouzitého IQRF vysielaca
TR-72D s integrovanou PCB anténou. Vysiela¢ TR-72D obsahuje 8 bitovy mikro-
kontrolér PIC16LF1938-1/MV, ktory riadi vysiela¢, LDO regulator vstupného a vy-
stupného napatia MCP1700, snimac teploty MCP9808, 256 kbit EEPROM 24 A A256
a RF IC SPIRIT1 [24].

+3V

PIC16LF1938-I/MV
SPIRIT 1

MCLR 7x200

26,
RX/RC7 —l:l—l
13 IO/RX/SDO |C8
SDO/RC5 — }
12 lo/sbl [c7
> XS] AnNTA <}:{> SDA/SDI/RC4 -
<6 L J— l0/SCK |c6

SCL/SCK/RC3
4 IO/TX/SS |C5
—_I_ AN4/SS/RA5 e
28 14
—|RAT TX/RC6 5 ‘
22 Prerusit / zobudit
5 AN11/RB4
GND 2
GND 18l anD RA3
4c| GND
—T
2x10k
[ mcP1700 MCP9808
c3| vIN 3 vaylB V17 vee
24 1 A2
GND LDO out RB6 - > SDA Al
1 S1 RA6 S[scL A0
J. ~{ALERT  GND
C2|10/VouT 2x200 -
[ +—
ci1jio — 27 no/ANO 24AA256
— 8l scL vee
5 spa A0
zelena® 25 4
LED1 RB7 . wp A1
& 5 GND A2
cervena 1
1 LED2 RA2
2 x 470

Obr. 3.2: Vnitorné zapojenie IQRF vysielaca TR-72D
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3.1.3 Vyvody vysielaca TR-72D a ich funkcionalita

V tabulke 3.2 je uvedend funkcionalita jednotlivych pinov vysielaca TR-72D. Vlast-
nosti jednotlivych pinov st taktiez dolezitou informéaciou pri navrhu obvodu pre dany
vysielac. Vysiela¢ TR-72D disponuje pinom pre napédjanie obvodu (C3), zemniacim

pinom (C4). Ostatné piny slizia na komunikaciu s vysiela¢om podla zvoleného typu

komunikécie.

C1

C2

C3

C4

C5

C6

C7

C8

10/ADC/C-IN

10/VOUT

VIN

GND

10/ADC/TX/-SS/PWM/COUNT

10/SCK/SCL

10/SDI/SDA

10/RX/SDO

vSeobecny 1/0 pin
anal6govy A /D vstup

vstup komparatora

vSeobecny 1/0 pin
vystup +3 V z LDO

vstup pre napajacie napatie
zemniaci pin

vSeobecny 1/0 pin
SPI sleave select
anal6govy A /D vstup
vystup komparatora
UART TX

PWM vystup

programovatelny pull-up a wake up

vSeobecny 1/0 pin
SPI clock vstup
12C clock

vSeobecny 1/0 pin
SPI data
12C data

vSeobecny 1/0 pin
SPI datovy vystup
UART RX

Tab. 3.2: Funkcionalita jednotlivych kontaktov vysielaca TR-72D
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3.1.4 Dosah pokrytia vysielaCom TR-72D

Pokrytie vysielacom sa lisi v zavislosti na réznych parametroch konkrétnej instala-
cie. V pripade obkolesenia vysielaca predmetmi ako si napriklad velké batérie alebo
kovové predmety sa vyzarovany signal odraza naspéat a nasledne posobi proti sig-
nalu vysielaca, a tym znizuje jeho dosah. Dosah vysielaca je taktiez ovplyvnitelny
softvérovo. Vysielaci vykon vysielaca je mozné nastavit pomocou vyberu z 6smich
urovni. Velky vplyv na dosah vysielaca ma orientécia a ulozenie samotného vysie-
laca, pretoze vysielacia charakteristika antény nie je na vSetky smery rovnaka ako

je vyobrazené na obr.3.3 [24].

. D
PCB PCB Anténa
Anténa S
IQRF IQRF Vysielac
Vysielac
A) Horizontalne B) Vertikalne
uloZenie vysielata uloZenie vysielaca

Obr. 3.3: Tvar dosahu vysielaca pri réznom ulozeni

Poznamka: Oranzova ¢iara znazornuje tvar oblasti pokrytej vysielacom.

3.2 Konektor vo formate SIM karty KON-SIM-02

KON-SIM-02 je konektor urceny na pripojenie IQRF vysielacov. Je kompatibilny
s mnohymi modelmi, vratane modelu TR-72Dx, ktory je v tejto praci pouzity. Ko-
nektor je urceny na pajkovanie priamo na dosku. Je zhotoveny z odolného plastu
a vyrobca deklaruje vydrz 10 000 pripojeni. Kontakty st vyrobené z bronzu s prida-
nim fosforu a kontaktné plochy st zase vyrobené z pozlateného niklu. Prechodovy
odpor kontaktov je urceny maximalne na 100 MS2, ale idealna hodnota prechodového
odporu je 50 Mf). Konektor je dimenzovany na prudy do 0,5 A. Pracovna teplota
tohto konektoru je Siroka a to v rozpéati od -40 az do +85 °C [25], [26].

43



Obr. 3.4: SIM konektor pre pripojenie vysielaca k modulu

3.3 Gateway GW-USB-06

Gateway GW-USB-06 je gateway alebo aj koordinator, ktory vychadza z TR-7xD
architektiry a je priamo prepojitelny do pocitaca prostrednictvom USB rozhrania.
Tento gateway je urceny na prepojenie pocitaca so sietou IQRF zariadeni. Vyhodou
tohto zariadenia je to, Ze pouzivatel je schopny naprogramovat si vlastné Specifické
funkcie pre svoje vyuzitie. Gatway ma taktiez viacero pokrocilych funkcii ako si
diagnosticky pripravok pre aplikacie, bezdrdtovy programéator (REFPGM) pre vysie-
lace a RTCC (hodiny s redlnym casom). Vysielaci vykon koordinatora je 11 dBm
a jeho maximalna prenosova rychlost je 19,836 kbps [27].

Obr. 3.5: IQRF USB koordinator
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3.4 Zbernica M.2 key E

M.2 je standard, ktory sa pouziva na pripojenie rozsirujicich kariet v pocitacoch
a inych zariadeniach priamo na ich zakladnych doskach. M.2 - je nahrada za mSATA
rozhranie, ktoré bolo Intelom predstavené v roku 2012. Pouzitie tohto rozhrania je
velmi roznorodé, pretoze je schopné prenasat rozne signaly ako st SATA, USB alebo
PCle, ¢o umoznuje zariadeniam vyuzivajicim toto rozhranie rozsirit svoje moznosti
o siete WLAN, Bluetooth a pod. Velmi ¢asto sa pouziva toto rozhranie na pripojenie
SSD disku v notebooku alebo inom zariadeni. Moduly M.2 si kompaktné a maju
velmi flexibilné vlastnosti vhodné pre merania. V praxi sa v elektronickych zaria-
deniach pouziva mnoho dostupnych druhov konektorov tohto rozhrania oznacenych
pomocou slovicka key (kIic¢) v kombindcii s velkym pismenom abecedy. Jednotlivé
prevedenia je mozné aj navzajom kombinovat. Na doske pouzitej v praci je do-
stupné prevedenie M.2 key E. Toto prevedenie kontaktov rozhrania sa sklada z 12
a 19 kontaktnych ploch, ktoré si oddelené medzerou. Oznacenie key E neznamena

len rozdielny vzhlad konektora, ale taktiez aj podporu iného mnozstva a druhu pre-

nosového signélu. M.2 key E podporuje prenos 2x PCle a USB signal [28], [29].

l |
1
\

™

Obr. 3.6: Zbernica M.2 key E na BPC-IOT doske
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3.5 Zbernica mini PCI-Express

Mini PCI-Express (PCle) je zbernica, ktord je v dnesnej dobe velmi ¢asto pou-
zivana v pocitacoch a inych elektronickych zariadeniach vyzadujucich pripojenie
externého zariadenia s vysokou prenosovou rychlostou. PCle zbernica je vyuzivana
na dudl-simplexné, point-to-point nizkonapatové sériové spojenia. Prenos signélu je
zabezpeceny vysoko-rychlostne az 2,5 Gbit za sekundu s 8/10 bitovy kédovanim,
aby sa do datového toku vlozil hodinovy signal. Na prenosovej strane si paralelné
data posunuté sériovo a na prijimacej strane st zase data posunuté do registrov po-
uzivanych pre paralelny vystup dat. Na tejto strane prijimac taktiez znovu obnovi
hodinovy signal prendsany s datami. Kanal PCle je tvoreny vysielacim a prijima-
cim nizkonapafovym diferencidlnym signalnym parom. Pakety s datami si posie-
lané simplexne s frekvenciou 2,5 GHz. Vysielaci aj prijimaci kandal prenasaju data
s rychlostou 250 MBps, ¢o v kombinacii tvori 500 MBps. Prenos méze byt tvoreny
viacerymi kanalmi v zavislosti od prevedenia x1, x4, x8, x16 a x32. Toto prevedenie
ma potom aj vplyv na sposob pouzitia. NajcastejSie pouzivané prevedenia st x1
pre desktopy, x4 pre servery a x16 je casto vyuzivana grafickymi kartami. Riadiace
impedanc¢no diferencidlne stopy umiestnené na doske st 100 2. Prenasany signal
dosahuje roznu amplitidu v zavislosti od vyznamu signalu. Prvy bit je prenasany
s amplitidou viac ako 800 mV a kazdy dalsi bit ma amplitidu 500 mV. Kazda matica
PCle je navrhnuta s autokonfiguraciou, to znamena, ze ak je pripojené zariadenie
s mensou zbernicou, piny st automaticky rozpoznané a informacie su distribuované
spravne [30].

ol
O0o

b

Obr. 3.7: Zbernica mini PCI-Expres na BPC-IOT doske
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3.6 Rozhranie 12C

12C je zbernica, ktora bola vyvinuta firmou NXP Semiconductors. 12C je zbernica,
komunikujica za pouzitia dvoch vodicov, radiaca sa medzi jednoduché zbernice.
Komunikacia po zbernici prebieha synchrénne, a preto je jeden z vodicov oznaceny
SCL (Synchronization CLock) a druhym vodi¢om st prenasané data. Tento vodi¢
nesie oznacenie SDA. Pripojené zariadenia pracuju v rezime s otvorenym kolektorom
(open drain). Pri pripojeni takéhoto zariadenia sa vyuzivaji pull-up rezistory, ktoré
st pripojené medzi napajacim napatim a jednym z vodicov tejto zbernice. Vacsinou
sa vyuzivaju rezistory s odporom 4700 ohmov (4k7). Takéto zapojenie v obvode za-
bezpedi to, ze lubovolné zariadenie moze v ktoromkolvek ¢asovom okamihu zmenit
hodnotu na zbernici tak, ze ziadne zariadenie by nemalo byt poskodené. Zakladna
stavba tejto zbernice sa skladd z minimalne jedného master zariadenia riadiaceho
komunikéciu, ktora prebieha na zbernici a generujiceho hodinovy CLK (clock) sig-
nal a jedného zariadenia typu slave, ktoré reaguje na data od master zariadenia.
Zariadenie typu slave je vicSinou nejaké zariadenie na periférii.

Ak master zariadenie chce zacat komunikaciu vysle startovaciu sekvenciu, ktora
pocas vysokej tirovne SCL zmeni SDA do nizkej irovne, nasledne sa do nizkej irovne
zmeni aj SCL. Tato Startovacia sekvencia je potrebnd, lebo v pokojovom rezime st
oba kontakty v logickej 1, ¢ize vo vysokej urovni. Nasledne je odoslana 8 bitova
adresnd sekvencia, ktora urc¢i akym smerom bude komunikacia pokracovat. Master
zariadenie pocas deviateho hodinového impulzu nechd SDA vo vysokej irovni. SDA
je stiahnuté do nizkej Grovne az v okamihu, ked je rozpoznané nejaké slave zaria-
denie, ktoré je spravne adresované a je pripravené na komunikaciu. Tento proces sa
nazyva potvrdenie (Acknowledge), z ¢oho pochddza aj skratka tohto bitu (ACK).
Tento bit je pouzivany po kazdom komunikacnom bite. Jeho funkciou je potvrdit
schopnost dalsej komunikacie, ktora je signalizovana nizkou uroviiou ACK. Ak by
ACK neskoncilo v nizkej trovni, komunikacia bude prerusena a ukoncend. Komu-
nikacia sa ukoncuje vyslanim sekvencie stop (pocas vysokej trovne SLC je SDA

uvolnené) [31].

«——SDA—>

MASTER SLAVE

——SCLK—

Obr. 3.8: Architekttura 12C
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3.7 Rozhranie UART

Komunika¢ny protokol UART (Universal Asynchronous Reciever-Transmitter) je
asynchrénneho charakteru, ktory vie pracovat v plne duplexnom rezime. UART je
¢asto pouzivany protokol v telekomunikacnych a kontrolnych systémoch. UART ko-
munikuje po dvoch signalovych trasach, aby bolo dosiahnuté prave plne duplexné
spojenie. Komunikacné cesty st oznac¢ené RXD a TXD. Architekttira komunikacného
protokolu UART sa sklada z generatoru prenosovej rychlosti, prijimacieho a vysie-
lacieho modulu. Generator prenosovej rychlosti ma za tlohu urychlit asynchrénny
sériovy prenos dat. Generator prenosovej rychlosti pracuje ako rozdelova¢ hodino-
vého signalu. Prijimaci modul prijima data prichadzajice na kontakty tohoto mo-
dulu. Zaciatok prijimania signalu je oznaceny prechodom vysokej irovne 1 do nizkej
urovne 0. Vysielaci modul meni data z paralelnych na sériové a pridava kontrolné
bity. Z ¢asovacieho diagramu UART protokolu je zrejmé, Ze stav ne¢innosti je pocas
vysokej drovne signalu. Zmena tejto drovne na nizku znaci zacCiatoény bit, nasle-
dovnych 8 bitov st prenasané data. Po prenasanych datach nasleduje koncovy bit,
ktorym je zaznacené to, ze data uz boli spracované. Po tomto bite moze zariadenie

znova prejst do stavu necinnosti do tzv. idle mode [32].

™ » RX
Generator Generator
prenosovej —> JART 1 UART 2 {«—{prenosovej
rychlosti rychlosti
RXe ™

Obr. 3.9: Architektira UART

3.8 Rozhranie SPI

SPI (Serial Peripheral Interface) je sposob komunikécie zalozeny na dvoch moduloch
master a slave. SPI protokol vyuziva 34N ciest, kde pre N plati, ze udava pocet slave
modulov. Tieto cesty zastavaju funkcie MOSI (Maste Out Slave In), MISO (Master
In Slave Out), SCLK (Slave Clock) a SS (Slave Select).

Architektura komunikacného protokolu SPI je rozdelena do troch blokov:

e Generator hodinového signalu

e Master modul
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o Slave modul
Vyssie uvedené cesty MOSI, SS a SCLK st stucastou prave Master modulu. MOSI
cesta je vyuzivana na komunikaciu mastru so slave. MISO je jedinad cesta riadena
slave modulom, pouzivand na vystup informéacii z daného modulu (senzoru). Frek-

venciu poskytovania dat slave modulom uré¢uje SCLK master [32].

Generator hodinového
signalu

——MOS|——

«——MISO—

SPI Master SPI Slave

——SCLK—

- SS—

Obr. 3.10: Architekttura SPI

3.8.1 SPI v IQRF

Pre komunikaciu s vyuzitim SPI v zariadeniach technologie IQRF je ddlezité spravne
implementovat Struktiru odosielanej spravy napr. od mastra. Tato struktira obsa-
huje niekolko bajtov na zaciatku kazdej spravy, ktoré prikazuju slave zariadeniu ako
ma so spravou postupovat v dalSom spracovani. Zakladnym delenim SPI paketov je
paket typu SPI _CHECK a SPI _CMD.

SPI CHECK neobsahuje ziadne telo spravy, iba sa dotazuje na aktivitu opacnej
strany v SPI komunikéacii. V praxi je tento paket pouzivany velmi ¢asto a zariadenia
si vymienaju informécie o svojej aktivite priblizne kazdych 10 ms. Implementacia
paketu SPI CHECK je pomerne jednoducha, pretoze cely paket je reprezentovany

iba jednym znakom a to v hexadecimalnom tvare ¢isla 0 - (0x00) vid. obr.3.11.

SPI_CHECK

0x00

Obr. 3.11: SPI_CHECK paket
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SPI _CMD je uz na implementaciu o cosi narocnejsi, pretoze tento paket ob-
sahuje uz viacero casti vid. obr.3.12. Prvou castou je informacia o tom, Ze je to
read/write SPI_CMD paket, ¢o je reprezentované prvym hexadecimélnym znakom
(0xF0). Druhym ¢islom v pakete je takzvany PTYPE, ktory je tvoreny 8 bitovym
¢islom vid. obr.3.13. Bit s ¢islom 7 ma hodnotu 1, ak sa maju data prepisovat alebo
0 v pripade, Ze chceme aby tieto data nezmenili predosli hodnotu tdajov. Ostat-
nych 7 bitov vyjadruje dlzku déat v sprave (SPIDLEN - 1 aZ 64 bitov), ktora bude
nasledovat. Dal$ich n znakov je samotna spréava - napriklad odosielana teplota. Tieto

znaky spravy sa oznacuju ako:
DMy, DM, ..., DMspipren
Predposlednym znakom v pakete je kontrolny znak CRCM, ktory je vypocitany ako:
SPI CMD xor PTY PE xor DM, xor DM, xor ... vor DMgsprpren xor 0xbF

Takto vytvoreny paket je pripraveny na prenos dat z mastra do slave zariadenia,
ktory je v nasom pripade realizovany prenosom dat z Raspberry Pi pico (master)
do IQRF vysielaca (slave). [33]

SPI_CMD| PTYPE DM DM» DMspipLen| CRCM

Obr. 3.12: Paket SPI komunikacie v IQRF

b7 b6 b5 b4 b3 b2 b1 b0

CTYPE SPIDLEN

Obr. 3.13: Tvorba znaku PTYPE

3.9 Navrh obvodu pre IQRF modul

V nasledujicich podsekciach si popisané zakladné bloky, ktoré st potrebné pre spravne
napajanie a komunikaciu IQRF modulu a dosky BPC-IOT, na ktorej je modul osa-
deny. Pre pripojenie IQRF vysielaca a dosky BPC-IOT bola vybrana karta v pre-
vedeni mini PCle.

Zapojenie modulu bolo navrhnuté podla odporucani vyrobcu. Schéma tohto
zapojenia bola navrhnutd pomocou programu Altium Designer. Vysledna schéma
IQRF modulu sa nachadza v prilohe C.
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3.9.1 Napajanie

Pri napajani je délezité dbat na preciznost, hlavne ak je pouzité napéatie Z DC/DC
menica alebo pulzného zdroja, pretoze tym vieme zabranit vzniku dalsich komplika-
cii. Pouzity vysiela¢ obsahuje vstavany napéatovy regulator (LDO) s malymi stratami
(obr. 3.14), ktorého vstupné napétie by malo byt z rozsahu 3,1 V az 5,3 V. Vystupné
napétie tohto regulatora je +3 V s toleranciou 60 mV, ktoré je urcené hlavne na na-
pajanie vnutornych obvodov vysielaca. Vyhodou vstavaného regulatora napétia je

externy vystup napétia pre napajanie pridavnych obvodov az do odberu 100 mA [34].

MCP1700
VIN 3 2 +3V

GND
J_1

Obr. 3.14: Regulator napéatia vstavany vo vysielaci

3.9.2 Stabilizacia napatia (odstranenie spatnej vazby)

Spatna vazba sa odstranuje, aby sa zabezpecilo dostatocne stabilné vstupné napétie
bez neziaducich emisii. Napajaci zdroj musi byt dostatocne stabilnym, nakolko po-
cas vysielania a prijimania je odber elektrickej energie nestaly a kolise v zavislosti
na vykone. Neschopnost zdroja dodavat konstantné napéatie by ovplyvnilo celkové
spravanie vysielania a prijimania, ako st napr. dosah ¢i iné vysielacie alebo prijima-
cie parametre.

Stabilitu zdroja vieme zabezpecit pripojenim stabilizacnych kondenzatorov na pri-
vody napétia pre vysiela¢ a uzemnovaci kontakt. Stabilizacné kondenzatory by mali
byt pripojené ¢o najblizsie ku kontaktom vysielaca. Typ a velkost kondenzatorov
je potrebné vyberat podla typu aplikacie a kvality privodného zdroja napétia. Naj-
Castejsie je pouzivana dvojica tantalového kondenzatora s hodnotou okolo 10 uF
a keramického kondenzatora s kapacitou z rozmedzia 100 nf az 1 puF. Ak chceme od-
stranif rusivé frekvencie, nimi sposobené prechodové pridy a zvlnenia z frekvencii
blizkych GHz, je potrebné este pridat kondenzator s nizkou kapacitou - iba nie-
kolko desiatok pF. Pravidlom by malo ostaf to, ze ¢im nizsi predradny kondenzator
je pripajany do obvodu, tym by mal byt pripojeny blizsie ku napatovému vstupu

do vysielaca [34].
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3,3V s HW resetom _ _ 3,3V s HW resetom

[F
% u

F | 22pF

GND GNp  Stabilizaéné kondenzatory pre odstranenie spitnej viizby

Obr. 3.15: Stabilizacia napétia

3.9.3 Filtracia rusenia

Dolezitou vlastnostou napajacieho zdroja je, aby dokazal zabranit sSireniu precho-
dového prudu vystupnej frekvencie cez vedenie elektrickej energie. Z tohto dovodu
je potrebné dodrziavat optimélne rozlozenie stuciastok na doske plosnych spojov.
Spravne filtrovany musi byt aj napajaci zdroj. Pre filtraény okruh plati zasada,
ze by mal byt umiestneny ¢o najblizsie ku vstupu napétia do vysielaca. Pri napajani

zo zdroja s predpokladom uz vyfiltrovaného napétia tento blok mozno vynechat [34].

3.9.4 Odpajanie (hardwerovy reset)

Ak je IQRF vysiela¢ ulozeny na tazko dostupnom mieste, pri poruche alebo novom
nastaveni, je vhodné doplnif modul o funkciu vzdialeného resetu. Kedze mini PCle
karta disponuje kontaktom s privedenym resetovacim signalom, dosiahnutie funkcie
vzdialeného resetu je pomerne jednoduché. Na tento jednoduchy obvod pouzijeme
komplementarne zapojenia MOSFET tranzistorového paru. Pre jednoduchost je mo-
dul vybaveny aj tlacidlom pre reset vysielaca manualne priamo na doske. Sucastou
obvodu je aj odpor s nulovou hodnotou pre znefunkcénenie daného obvodu kvoli
neskorsim vyvojovym potrebam. V obvode je tiez zakomponovand zelend luminis-
cen¢né didda pre signalizaciu funkénosti privedeného napajacieho napatia. Zapojenie
tohoto obvodu je na obr.3.16 [34].
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Obr. 3.16: Hardwérovy reset
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4 Realizacia hardvéru laboratornej ulohy

Technicka realizacia laboratérnej ilohy obnasa vyrobu modulu s ipravou jeho roz-
merov, osadenia modulu stciastkami, vybavenie modulu IQRF vysielacom a osade-
nie modulu s vysielacom do slotu mini PCle karty na BPC-IoT doske. Tato doska
musi byt spravne vybavena jumper prepojkami pre funkcénost pripojenych zariadeni.
V neposlednom rade musi byt ku BPC-IoT doske pripojené teplotné ¢idlo na ziskanie

teploty okolia.

4.1 Vyroba PCB dosky modulu

Z navrhu v programe Altium Designer boli vytvorené potrebné subory (NC Drill
a Gerber), ktoré si dostupné v prilohe E pre vyrobu dosky modulu. Vyroba bola
po odporuceni vediucim prace a predoslych skusenostiach zadana firme JLC PCB,
kam boli zaslané podklady pre vyrobu modulu. Pre vyrobu dosky boli zvolené na-

sledovné zdkladné nastavenia:

Parameter Hodnota | Jednotka
Zakladovy material FR-4 -
Povrchova tprava HASL (s olovom) -
Farba PCB zelend -
Farba popisu biela -
Rozmery dosky 30 x 51.8 mm
Hribka PCB 1 mm
Tolerancia rozmerov +0,2 mm

Tab. 4.1: Parametre PCB zaslané do vyroby

Parametre pre vyrobu dosky sa vo velkej miere zhoduji so zakladnymi paramet-
rami pre vyrobu PCB dosky. Jedinym rozdielom pri vyrobe modulu bolo pouzitie
tensej dosky. Zvolena hriibka je iba 1 mm a to z dévodu osadenia modulu do slotu
mini PCle karty, ktory je pripraveny na osadenie modulu prave s tymito rozmermi.
Druhym rozdielom je znizena tolerancia rozmerov, ktora je potrebna pre presnost

kontaktov mini PCle karty a jej slotu.

4.2 Uprava rozmerov dosky modulu

Pri navrhu modulu v prevedeni mini PCle boli pouzité rozmery pre dosku dostupné

na internete, ktoré boli nasledne skontrolované odmeranim inej dosky v prevedeni
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mini PCle karty. Aj napriek takejto dvojndsobnej kontrole bola doska, po vyrobe
priblizne o 1 mm vi&ia ako bolo mozné vlozit do slotu na BPC-IoT doske. Up-
rava rozmerov bola vykonand pomocou brusneho papiera a pravouhlost vybrisenej
casti bola zabezpecend pravouhlou stistavou na brisnej doske. Vybrisena cast dosky
modulu bola néasledne osetrena tekutym lakom na PCB dosky.

o
OB
NI
S g &

47.83

# ¥

SW1RESET

3.07 —

Obr. 4.1: Rozmery modulu

4.3 Osadenie dosky modulu suciastkami

Pre prvi prototypovi verziu modulu bolo zvolené rucné osadenie dosky stuciastkami
v Studentskom laboratériu. Pouzité rezistory boli z rady E24 - 1% a E12 - 5%. Po osa-
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deni stuciastok bola otestovana zakladna funkcionalita dosky - premeranie odporu
a napétia. Vykonana bola aj kontrola spojenia komunikac¢nych ciest SPI zbernice
medzi kontaktami slotu mini PCle karty na BPC-IoT doske a SIM konektorom
na doske modulu. Prototyp modulu bol dalej pouzity pre vyvoj laboratérnej tlohy
a programové testy.

1GRF modul
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Obr. 4.2: Osadena doska modulu stéiastkami

4.4 QOsadenie BPC-loT dosky

BPC-IoT doska je doska, na ktorej je osadeny mikrokontrolér Raspberry Pi Pico.
V prevedeni laboratérnej tlohy je potrebné tento mikrokontrolér naprogramovat
tak, aby pomocou IQRF vysielaca bola odoslana teplota z externého cidla na ko-
ordinator. Pred samotnym programovanim je nutné si ku doske pripojit vsetky vy-
uzivané casti obvodu tak, aby bolo mozné teplotu ziskat a odoslat. Na BPC-IoT
dosku pripojime teplotné ¢idlo AHT20. Toto ¢idlo s mikrokontrolérom komunikuje
po zbernici 12C, z ¢oho jasne vyplyva aj miesto jeho pripojenia ku BPC-IoT do-

ske. Dalsou nevyhnutnou st¢astou pre odoslanie teploty je IQRF vysiela¢. Vysielaé
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TR-72DA vlozime najskor do v praci navrhnutého modulu, ktory néasledne cely vlo-
zime do slotu pre mini PCle kartu. Ako posledné je potrebné na BPC-IoT doske
umiestnit jumper prepojky na spravne kontakty na doske. Kedze modul je v preve-
deni mini PCle karty je nevyhnutné umiestnif jumper prepojku prave na tieto piny.
Druhé prepojka sliziaca na zvolenie spravnej irovne komunikacnej logiky musi byt
umiestnena do polohy 3,3 V, pretoze vyuzivany IQRF vysiela¢ pracuje prave s touto

logickou napétovou droviou.

E BPC-loT Board 5
T—t= €USB C> ' <«12C»| AHT20

PC
IQRF
modul
USBA
1
SPI

RF 868MHz +

IQRF OD @o IQRF
KOORDINATOR VYSIELAC

Obr. 4.3: Blokova schéma zapojenia pouzitych zariadeni

Obr. 4.4: Osadend BPC-IoT doska
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5 Navrh laboratdrnej dlohy

Cielom laboratérnej tlohy je zoznamit studentov s moznostami a zakladnymi funk-
ciami technologie IQRF. Technolégia IQRF ako taka neobsahuje iba konkrétny hard-
vér (vysielaCe, gateway Ci senzory), ale aj ovladaci a programovaci softvér IQRF IDE.
Laboratérnu ilohu sme rozdelili na dve casti:

o Vytvorenie komunikécie bod - bod

o Vytvorenie mesh siete

« Bonusova uloha

5.1 Zakladné informacie o vyvojovom prostredi IQRF
IDE

Laboratorna tloha bola realizovana vo vyvojovom prostredi IQRF IDE, ktoré je
orientované na vyvoj projektov technolégie IQRF s grafickym uzivatelskym prostre-
dim. Pre vyvojarov poskytuje komplexnost, pretoze IQRF IDE podporuje dizajno-
vanie, nahravanie, debugovanie, testovanie a idrzbu pre vyvijané projekty.

Hlavné casti IQRF IDE:

e Debugger a konfiguracny nastroj

o Komunikacny terminal a testovaci nastroj

o Spravca siete IQMESH (manazment, sprava, vizualizacie a testy)

o Servisny nastroj CATS (skener, tester, analyzator)

o Nastroje na aktualizaciu operacného systému pre vysielace a firmvéru pre USB

zariadenia

5.2 \Vytvorenie point to point komunikacie

Prva ¢ast laboratornej ulohy je zamerand na precvicenie point to point (bod - bod)
komunikécie, teda spojenia medzi dvoma bodmi (vysielacom a prijimac¢om, pripadne
obojsmerne medzi dvoma vysiela¢mi alebo medzi vysielacom/uzlom a koordinato-
rom). V laboratérnej tilohe sme vyuzili ndm dostupné zariadenia a bola vytvorend
point to point komunikécia medzi USB koordinatorom (GW-USB-06) a vysielacom
(TR-72DA), kde bol koordinator nastaveny tak, aby sa spraval ako jednoduchy priji-
mac signalu (sprav). Na vytvorenie tejto komunikacie bolo potrebné vytvorit v prog-
rame IQRF IDE projekt a vytvorit program (TeplotaTX) v jazyku C pre odoslanie
teploty zo vstavaného teplotného cidla. Program pre prijimanie dat bol pouzity

7 demo cvicenia E02-RX.c.
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Program TeplotaTX.c bolo potrebné nahrat do vysielaca pomocou programova-
cieho modulu a program E02-RX.c zase do USB gateway priamo z pocitaca. Takto
vytvorené a nastavené zariadenia vedia odosielat a prijimat spravy po stlaceni ap-
lika¢ného tlacidla (na doske oznacené ako bonding). V terminal logu prostredia
IQRF IDE je mozné vidiet prijaté spravy vid. obr.5.1 a po rozkliknuti danej spravy
je mozné vycitat jej obsah a detail (odosielatel, velkost) vid. obr.5.2. Presny névod

s jednotlivymi krokmi sa nachadza v prilohe A.

Terminal Log

view: [ AutoScrol | Separator: (8 Horzontal (8 Vertical | (8 Data Displaying I NSESSSSSS | File: none COHE
Line Time Rx/Tx Length Data HEX DPA Message = Error NADR PNUM PCMD
1 19:34:48.513  Rx 9 54.3D.20.32.39.2E.32.80.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
2 19:35:05.243 Rx 9 54.3D.20.32.38. 2E.39.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
3 19:35:11.820  Rx 9 54.3D.20.32.38. 2E.38.80.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
4 19:35:18.007 Rx 9 54.3D.20.32.38. 2E. 38.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
5 19:35:23.333  Rx 9 54.3D.20.32.38. 2E.37.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
6 19:35:29.908  Rx 9 54.3D.20.32.38. 2E.36.80.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
7 19:35:36.486 Rx 9 54.3D.20.32.38. 2E. 36.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
8 19:35:43.059  Rx 9 54.3D.20.32.38.2E.35.80.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
9 19:35:49.641 Rx 9 54.3D.20.32.38. 2E.35.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
10 19:35:56.213 Rx 9 54.3D.20.32.38. 2E.34.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
11 19:36:02.802  Rx 9 54.3D.20.32.38.2E.34.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
12 19:36:09.376  Rx 9 54.3D.20.32.38. 2E.33.80.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
13 19:36:15.945 Rx 9 54.3D.20.32.38. 2E.33.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
14 19:36:22.522  Rx 9 54.3D.20.32.38. 2E.33.80.43. DPA Request 0x54 Reserved 020 User Peripheral 0x20 0x32 Unknown
15 19:36:29.110 Rx 9 54.3D.20.32.38. 2E. 33.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown
16 19:36:35.679  Rx 9 54.3D.20.32.38. 2E.32.B0.43. DPA Request 0x54 Reserved 0x20 User Peripheral 0x20 0x32 Unknown

Obr. 5.1: Terminal log v IQRF IDE

5.3 TeplotaTXIQRF.c

Program v jazyku C vyuziva funkcie z IQRF OS (kniznica IQRF.h). Program nacita
teplotu z integrovaného teplotného cidla, upravi nacitané data z c¢idla, skonvertuje
ich na teplotu a tito teplotu zaokrihli na potrebny pocet desatinnych miest. Prog-
ram pripravi text spravy, do ktorej je vlozena teplota. Tato sprava je nasledne odo-
slana z IQRF vysielaca po stlaceni aplikacného tlac¢idla na module alebo BPC-1oT
doske (BUTO0). V programe su vyuzité funkcie na riadenie SPI zbernice (startSPI,
enableSPI), kopirovanie dat z SPI buffra (bufferCOM) do odosielacieho buffra (buf-
ferRX) a odoslanie spravy prostrednictvom IQRF vysielaca (RFTXpacket). Zdro-

jovy kod tohto programu sa nachadza v prilohe F.

5.4 TeplotaTXRPPico.py

Program v jazyku microPython urceny pre riadiacu dosku BPC-IoT, ktora po stla-
¢eni tlacidla BUTO vysle signal cez SPI zbernicu na IQRF vysiela¢ pre odoslanie

spravy s teplotou, ktora je ziskavand internym ¢idlom na IQRF vysielaéi. (priloha F)
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Packet Inspector X
LastRecord: [ Jany [(JTx [JRx ([ ignore DPA

=] Mode: Terminal, Line: 5, Rx

Date: 17.05.2024
Time: 14:07:44.636
Length: 9

-] Data: [9]

[0] ox54 T 084 0101.0100
-[1] 0x3D = 061 0011.1101
[ o0x20 032 0010.0000
-[3] 0x32 2 050 0011.0010
[4 0x35 5 053 0011.0101
-[8] O0x2E . 046 0010.1110
[6] 0x30 0 048 0011.0000
-[71 oxBO . 176 1011.0000
[8] 0x43 C 067 0100.0011

[El Packet Inspector

Obr. 5.2: Detail prijatej spravy

5.5 ExternaTeplotaTXIQRF.c

Program v jazyku C vyuziva funkcie z IQRF OS (kniznica IQRF.h). Program najskor
nainicializuje zbernicu SPI. V nekonecnom cykle sa testuje stav zbernice SPI. Ak
nie je zbernica zaneprazdnena, v podmienke sa otestuje ¢i si na zbernici poslané
nejaké data a skontroluje sa CRC suma. V pripade, Ze zbernica je zaneprazdnena,
blikd LED. Poslané déata zo zbernice sa prenest do buffra na odoslanie (bufferRF)
cez vysiela¢. Néasledne sa data (teplota) odosle cez vysiela¢ na gateway. V pripade,
7e na zbernici neboli prijaté ziadne data do buffra na odoslanie, je prenesend sprava
"no data'. Ak sa na zbernici data objavili, ale CRC suma nie je korektné, je odoslana

sprava s textom "CRC err". (priloha F)

5.6 ExternaTeplotaTXRPPico.py

Program v jazyku microPython je urceny pre riadiacu dosku BPC-IoT board s mik-
rokontrolérom Raspberry Pi Pico. Program nacita teplotu z externe pripojeného
¢idla AHT20, pripojeného ku doske cez zbernicu 12C. Posklada SPI paket podla
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protokolu na odoslanie a vypocita CRC sumu, ktori vlozi do SPI paketu. Cely
paket prekonvertujte do pola bajtov na odoslanie cez funkciu spi.write. Program vy-
uziva kniznice pre komunikaciu po SPI a 12C zberniciach. Taktiez vyuziva kniznicu
pre komunikaciu s teplotnym ¢idlom AHT20. V prvej casti sa zadefinuji komuni-
kacné a ovladacie piny. Nasledne sa inicializuji obe zbernice a nastavia sa parametre
prenosu. S vyuzitim zbernice I2C sa nainicializuje teplotné ¢idlo AHT20. Po ini-
cializacii vSetkych potrebnych komunikaénych ciest sa nacita teplota z ¢idla. Tato
nacitana teplota sa posiela pre overenie na konzolu. Teplota sa skonvertuje na he-
xadecimalny tvar, obali sa ivodnymi bajtami a CRC podla protokolu SPI v IQRF.
Cely paket sa tiez vypise do konzoly na overenie. Pred samotnym odoslanim paketu
s teplotou je komunikacia na SPI zbernici zahdjena nastavenim riadiaceho signalu na
nizku troven (logicka 0) a po odoslani dat je tato komunikécia zase ukoncend nasta-
venim toho istého signalu na vysoku troven (logicka 1). Toto opakované odosielanie

teploty je vykondvané neustile pomocou nekoneéného cyklu. (priloha F)

5.7 Vytvorenie IQRF mesh siete

Pre vytvorenie siete mesh je potrebné pouzit koordinator a niekolko podriadenych
uzlov, ktoré budu siet tvorit a bude u nich fungovat routovanie na pozadi. Na vy-
tvorenie siete sa vyuziva proces, ktory sa nazyva bonding alebo jednoduchsie (pa-
rovanie). Aby tento proces fungoval je potrebné sa uistit, ze uzly (vysielace), ktoré
su v sieti pouzité, nie si aktualne sparované s inym koordinatorom. Pre uistenie sa
bolo na zaciatok druhej casti laboratornej tlohy vlozené zresetovanie bondovacich
nastaveni koordinatora aj uzlov za pomoci IQRF IDE v pripade koordinatora. V pri-
pade uzlov je tento reset vykonany pouzitim presnej kombindcie stlacenia tlacidiel
na doske. V programe IQRF IDE bolo potrebné pridat plug-iny pre koordinator
a podriadené uzly, ktoré boli nahrané do jednotlivych zariadeni. Néasledne bola vy-
tvorend siet mesh a v nej prebehol algoritmus objavenia a priradenia virtudlnych
smerovacich ¢isel.

Po vytvoreni siete bola navrhnuta kratka tloha o preskiimani parametrov siete
v programe IQRF IDE.
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Obr. 5.3: Zobrazenie mesh siete v zalozke map view v IQRF IDE

5.8 Bonus.py

Do laboratornej tlohy je pridana aj bonusova uloha, ktora simuluje realnu situaciu
s IoT sveta. Pre vyriesenie tejto tlohy bolo potrebné upravit program Externa-
TeplotaTXRPPico.py tak, ze funkcia ¢itajica teplotu z ¢idla zaokrihli jej hodnotu
na jedno desatinné miesto. Pre prenos aj zapornych teplot sa pouzije offset +40.
Takyto postup pre ziskanie teploty je mozné vyuzit napriklad v nasich klimatickych
podmienkach, v ktorych teploty v zime nie st nizsie ako -40 °C a v lete zase nepresa-
hujua 50 °C. Vysledné cislo reprezentujtice teplotu je potrebné este vynasobit ¢islom
10, aby sa nemusela prenasat desatinna c¢iarka. Takto upravena teplota pri odosielani
cez technologiu IQRF posiela vyrazne menej datovych bajtov, ¢im skracuje vysielaci
cas a tak Setri batériu. V laboratérnej tlohe gateway nie je naprogramovany tak,
aby si z prijatej hodnoty reverzne ziskal redlnu teplotu, ¢o vsak nie je problém na-
programovat pri redlnom pripade zapisu teploty napriklad do grafu na virtualnom

ulozisku cloud.
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Zaver

Tato bakalarska praca bola zamerana na vytvorenie laboratérnej tlohy z predmetu
Komunikac¢né systémy pre IoT, ktora sa venuje technologii IQRF. Pre potreby labo-
ratorne ulohy bol navrhnuty modul pre spojenie IQRF vysielaca a dosky BPC-IoT.
Vdaka tomuto modulu BPC-IoT doska dokaze komunikovat s IQRF vysielacom.

Modul bol navrhnuty tak, aby boli dodrzané odporucania vyrobcu pre spravne
napajanie IQRF vysielaca a pre jeho bezproblémovi komunikaciu s BPC-IoT dos-
kou. Navrh modulu bol realizovany v programe Altium Designer. Schéma zapojenia
modulu a navrh dosky plosného spoja si prilohou bakalarskej prace.

Po oboznameni sa s moznostami IQRF vysielaca a BPC-IoT dosky bola pre ko-
munikaciu zvolena zbernica SPI, ktora je vyrazne podporovand programovymi funk-
ciami IQRF zariadeni.

Modul bol vytvoreny v tvare mini PCle karty. Toto prevedenie bolo vhodnejsie
hlavne z propor¢ného hladiska, pretoze v praci pouzity IQRF vysiela¢ sa pripdja
do obvodu pomocou pomerne rozmerného SIM konektora.

Pre laboratérnu tlohu bol vybrany IQRF vysiela¢ TR-72-DA, ktory disponuje
integrovanou PCB anténou s dosahom 500 m volného priestranstva, ¢o je pre la-
boratorne vyuzitie maximalne postacujice. Vysiela¢ je taktiez velmi jednoducho
vyberatelny z obvodu, v ktorom je instalovany, vdaka uz spominanému SIM konek-
toru. Tento sposob pripojenia ulahcuje zmeny programu a nastaveni, ktoré su pocas
realizacie laboratérnej tlohy pomerne casté.

Ako koordinator je pouzity USB gateway technoldgie IQRF GW-USB-06, ktory
je, rovnako ako zvoleny vysielac¢, najvhodnejSou variantou pre laboratérne vyuzitie,
pretoze je pripojitelny priamo cez USB konektor k pocitacu, v ktorom je zobrazovana
prijata sprava.

Laboratorna tiloha bola navrhnuté tak, aby studentov zoznamila s IQRF techno-
légiou a jej moznostami v sieti mesh. Pocas vypracovania tlohy sa Studenti obozna-
mia aj s vyvojovym prostredim IQRF IDE, ktoré je vyuzivané pre programovanie
a spravu IQRF zariadeni. Taktiez sa zoznamia s moznostou poskytovania dat pre vy-
siela¢ prostrednictvom zbernice SPI, ktora je jednou z podporovanych zbernic IQRF
zariadeniami. Spracované data IQRF vysielacom st nasledne posielané v jednodu-
chej sieti na koordinator, ktory ich premietne do pocitaca prostrednictvom IQRF
IDE.

Sucastou bakalarskej prace st programy pre IQRF zariadenia v jazyku C a tak-
tiez programy pre BPC-IoT dosku s vyuzitim programovacieho jazyka microPython,
ktoré st pouzité v laboratérnej tlohe.

Laboratorna tloha je prelozena aj do anglického jazyka pre potreby vyucby za-

hrani¢nych studentov.
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Zoznam symbolov a skratiek

ACK Acklowledgement

A/D Analog / Digital

AES Advanced Encryption Standard
BLE Bluetooth Low Energy

C Koordinator

CLK Clock

CRC Cyclic Redundancy Check

CSMA-CA Carrsie Sence Multiple Access Collision Avoidence

DC Direct Curent

DSSS Direct Sequence Spread Spektrum
FEC Forward Error Correction

FSK Frequency Shift Keying

GND Ground

1C Integrated Circuit

IDE Integrated Desktom Enviroment
IEEE Institute of Electrical and Electronics Engineers
10 Input Output

IoT Internet of Things - Internet veci
IQRF Inteligent Quick Response Frequency
ISM Industrial Scientific Medical

LDO Low Dropout Output

LP Low Power

MCU MIcrocontroler Unit

MISO Main In Slave Out
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MOSI

OQPSK
oS
OTA
PCB
PWM
RF
RFPGM
RTCC
RX
RXD
SCL
SCLK
SDA
SPI

SS
STD
TX
TXD
UART
VIN
VOUT
WLAN

WMAN

Main Out Slave In

Node

Offset Qadrante Phase shift Keying
Operacny systém

Ower The Ai

Printed Circuit Board

Pulse Width Modulation
Radio Frequency

Radio Frequency Programming
Real Time Clock Calendar
Receive

Receive Data

Synchronous CLock

Slave Clock

Serial Data

Serial Pheripheral Interface
Slave Select

Standard

Transmit

Transceive Data

Universal Asynchronous Reciever-Transmitter
Voltage IN

Voltage OUT

Wireless Local Area Network

Wireless Metropolitan Area Network
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WPAN Wireless Personal Area Network

WSN Wireless Sensor Network

WWAN Wireless Wide Area Network

XLP Extra Low Power
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A Laboratéorna uloha IQRF mesh siete

A.1 Ciel merania

Cielom laboratornej tlohy je zoznamit studentov so zakladnymi funkciami a moz-
nostami IoT technolégie IQRF, pochopit topolégiu mesh a principy komunikacie

medzi zariadeniami v nej.

A.2 Zadanie

o Zoznamte sa so zariadeniami na pracovisku.

e Vytvorte jednoducht Point to Point komunikaciu medzi koordindtorom a vy-
sielacom. V tejto jednoduchej sieti naprogramujete dostupny mikrokontrolér
Raspberry Pi Pico tak, aby prenasal informacie o teplote z uzla na koordinator.

o Vytvorte sief s topoldgiou mesh obsahujtcu koordinator a dva uzly a zoznamte

sa s vplyvom zmeny polohy uzla na signal a topoldgiu mesh siete.

A.3 Teoreticky tvod

IQRF (Intelligent Quick Response Frequency) je bezdrotova technologia a platforma
pre IoT orientovana paketovo. Umozinuje posielat nizke mnozstvo dat s minimalnou
spotrebou elektrickej energie a maximalnou spolahlivostou. Technolégia je vhodna
st batériou napajané instalacie, aplikacie pre IoT, smart mesta ¢i budovy.

IQRF technoldgia pracuje v nelicencovanom Sub-GHz ISM (industrial scientific
medical) radiovom péasme (433, 868, 915 MHz) v zavislosti od kontinentu alebo
Statu instalacie. V Ceskej republike je pouzivané 868 MHz pasmo. Moduly IQRF
technolégie mozu pracovat v roznych topoldgiach ako napr. bod — bod, hviezda,
ale najCastejsie je pouzivana v mesh topoldgii. Na obr.A.1 je znazorneny typicky
dizajn IQRF siete obsahujici jednotlivé uzly (senzory) v mesh topoldgii, gateway,

cloud a pripojenie na internet (aplikdcia pre komunikaciu so svetom).
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IQRF MESH SIET

GATEWAY APLIKACIA

Obr. A.1: Struktira IQRF siete

Maximalny dosah jedného IQRF vysielaca je certifikovany na 500 m volného prie-
stranstva, ¢o pri pouziti viac ako 200 zariadeni v mesh topologii predstavuje rozlohu
az desiatky kilometrov stvorcovych. Z toho dovodu IQRF siet radime do kategorie
WMAN (Wireless Metropolitan Area Network). Na obr. B.2 je dosah IQRF siete
porovnany s dosahmi inych IoT sieti.

IQMESH (Inteligent Mesh) je patentovany meshovy komunikaény protokol po-
uzivany vramci ekosystému technoldgie IQRF. Je navrhnuty na sprostredkovanie
bezdrétovej komunikacie v mesh topoldgii, kde kazdé zariadenie mdze komuniko-
vat s okolitymi zariadeniami a potencidlne sluzit ako preposielaci uzol na rozsirenie
dosahu siete. Kazdy paket je smerovany uzlami na pozadi neobmedzujic ich funkcio-
nalitu. Tento proces je riadeny opera¢nym systémom a je nebadatelny pre uzivatela.
IQMESH podporuje viaceré smerovacie struktiry ako si: aplny mesh, redukovany
mesh, optimalizovany mesh, strom... Smerovanie méze prebiehat staticky, a taktiez
moze byt pod tplnou kontrolou uzivatela. Dynamické ¢asovanie s vyberom poctu
krokov v sieti a volitelnym ¢asovym tisekom umoznuje maximalnu priepustnost s mi-
nimalnym rusenim a spotrebou elektrickej energie. Efektivita a spolahlivost je do-
siahnuta pomocou takzvaného zaplavového mechanizmu, ktory funguje podobne ako
povoden - informécia je na miesto dorucenia poslana viacerymi moznymi cestami
- podobne ako voda pri povodni zaplavuje miesta kadial moze pretiect. Koliziam
v sieti sa predchadza pomocou systému Time Division Multiple Access, ¢o v pre-
klade znamena viacnasobny pristup s ¢asovym delenim.

Ostatné technické parametre siete su v tabulke tab B.1
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WPAN

@ Wi-Fi, Bluetooth, ZigBee

Q Wireless M-Bus, Wi-Fi LoRa, SigFox

g% IQRF
P88/
//

—

10-100 m

100 - 1000 m—>

1 -10 km—>|

10 - 100 km—>

Obr. A.2: Porovnanie dosahu viacerych sieti z IoT odvetvia

IQRF
Velic¢ina Jednotka Hodnota
Pracovna frekvencia MHz 433, 868, 916
Prenosova rychlost kbps 20
Max. dlzka prendSanej spravy byte 64
Max. dosah vo volnom priestranstve m 1000
Modulacia - GFSK
Topologia - mesh
Oneskorenie ms 60 - 100
Max. pocet uzlov na gateway - 65*103
Teoreticky cas zivota na AAA batérii rok 5-10

Tab. A.1: Prehlad parametrov IQRF siete

A.4 Postup pre vypracovanie merania

Najskor si skontrolujeme zapojenie pracoviska podla blokovej schémy B.3 a skon-
trolujeme polohu jumper prepojok prva v polohe pre logiku 3,3 V, druha v mieste

povolujicom mini PCle kartu.
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Obr. A.3: Blokova schéma zapojenia pracoviska

A.4.1 Point to point komunikacia

Pred vytvorenim point to point komunikacie je potrebné vytvorit a nahrat do BPC-
[0oT dosky program, ktory je v jazyku microPython. Tento program prijme teplotu
z teplotného senzora po zbernici 12C spracuje ju a podla IQRF SPI guide a vytvori
paket, ktory je prijaty IQRF vysielacom.

Spustite program IQRF IDE a vytvorte si novy projekt: New -> Non-networking
Demo -> Next. Projekt pomenujte a stlacte Next. TR Module nastavte na TR-
72Dx a IQRF OS ponechajte na najnovsej verzii: Finish -> Yes to All. Do no-
vovytvoreného projektu pridajte demo casti kodu - v lavej Casti obrazovky v za-
lozke Project kliknite pravym tlacidlom mysSi na Source -> Add -> FExisting
Item...-> ExternaTeplotaTXIQRF.c -> Open a prijimaciu cast pravym tla-
¢idlom mysi kliknite na Source -> Add -> New Non-networking Example....
V novootvorenom okne vyberte E02-example of simple RF receiving. Vyberte
a potvrdte demo kéd. -> Next -> Finish -> Yes -> Yes to All. V zalozke
Source by sa mali nachddzat casti kodu (ExternaTeplotaTXIQRF.c a E02-RX.c),
ak nie, zopakujte postup.

Ked méame vytvorené demo projekty, musime si vytvorit vystupné HEX sibory,
ktoré sa daji nahrat do jednotlivych zariadeni. Oznacte si krizkom prvy projekt
ExternaTeplotaTXIQRF.c a stlacte zelenid kocku (B.4 - 1) v hornej casti obra-
zovky. V zdlozke Output HEX (zalozka pod Source) sa objavi vytvoreny Hex File
s nazvom podla zdroja (TeplotaTX.hex). Rovnako vytvorte HEX file aj pre druhu
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cast E02-RX.c (E02-RX.hex).

Pre spravnu funkciu siete (aj Point to Point) je potrebné, aby boli obe zariadenia
nastavené na rovnaké frekvencné pasmo. Preto dvojklikom otvorte zalozku TR con-
figuration a RF band nastavte na 868 MHz, RF channel A na 67 a RF channel B
na 62. Tlac¢idlom Close -> Yes -> Save potvrdte vasu konfiguraciu. Této kon-
figurdcia sa objavi v zalozke TR configuration na lavej strane obrazovky.

Takto vytvorené vystupné HEX sibory a TR konfigurdciu vieme nahrat do jed-
notlivych zariadeni. Pripojte do pocitaca USB koordinator a v lavom dolnom rohu
obrazovky sa zobrazi blikajtci zeleny krizok s pomenovanim pripojeného zariadenia
GW-USB-06. Ak to tak nie je, je potrebné skontrolovat, ¢i nie je otvorené IQRF
IDE vo viacerych oknach alebo odpojif a znova zapojit programované zariadenie.
Ak uz blika zeleny kruzok, vsSetko je pripravené na nahratie programu. Do koor-
dindtora nahravame prijimaciu cast projektu, preto si oznacte v zalozke Output
HEX E02-RX.hex a v zdlozke TR configuration si oznacte vami vytvorentu konfigu-
raciu. Nasledne stlacte tlacidlo mikrokontroléra s modrou fajkou (B.4 - 2)
v hornej casti obrazovky. V dolnej Casti obrazovky sa objavi potvrdzujtica hlaska
o uspesnom nahrati programu do GW-USB-06. Pre nahratie vysielacej casti prog-
ramu najskor zasunte cerveny vysiela¢ do SIM slotu na programatore (modul so sivou
podstavou) a pripojte ho pomocou USB kabla do pocitaca. Nasledne v dolnej casti
obrazovky kliknite pravym tlac¢idlom mysi na zeleny blikajtci krizok a zvolte si
druhé zariadenie (CK-USB -04A). V zéalozke Output HEX vyberte TeplotaTX.hex
tla¢idlom mikrokontroléra s modrou fajkou (B.4 - 2) nahrajte program aj
do druhého zariadenia. Opéatovne sa objavi potvrdzujica sprava v dolnej casti obra-
zovky. Naprogramovany vysiela¢ vlozte naspat do BPC-IoT board. Tento program
prijme teplotu a po zbernici SPI a skontroluje jej spravnost a odosle ju na IQRF
koordinator. Spravnost prijatia spravy skontrolujte v ¢asti Terminal Log, ktora sa

nachadza v dolnej casti obrazovky.

Debug USE Device Tools Window Help

SET T AT Y IE N}

Terminal Log
View: [ |UseWimbers [ Auto Scroll

Obr. A.4: IQRF IDE pre lepsiu navigaciu
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A.4.2 IQRF mesh siet

Pre vytvorenie novej mesh siete je potrebné sa najskor uistit, ze pouzité prvky siete
(koordinator a uzly) nie st uz sparované s inymi prvkami. Preto vykondme reset
parovacich nastaveni najskor pre koordinator potom pre uzly.

Zacneme pridanim Plug-inov do projektu, ktoré bude potrebné nahrat do ko-
ordinatora a do uzlov. Pravym tlacidlo mysi klikneme na zalozku Project ->
Plug-ins -> Add -> DPA Plug-in... v novootvorenom okne zaskrtneme DPA-
Coordinator-SPI-7xD... a DPA-Node-STD-7xD... a potvrdime vyber tlacidlom OK.
Pri nahravani do jednotlivych zariadeni je potrebné, aby boli zaskrtnuté iba zalozky
Plug-ins s konkrétnou castou pre koordinator alebo pre uzol a v zalozke TR Con-
figuration konfiguracia z predoslého cvicenia. Rovnakym spdsobom ako v predoslej
casti nahrame Plug-in aj konfiguraciu do koordinatora a do uzlov. V tomto pripade
uz nie je potrebné vytvarat HEX stbory.

Ak mame tspesne naprogramovany koordinator aj uzol, moézeme zacat s reseto-
vanim predoslych informacii o parovani. Pre resetovanie koordinatora je potrebné
najskor koordinator pripojit k pocitacu. Nasledne zvolime zalozku IQMESH Ne-
twork Manager v dolnej casti obrazovky a v nej zase vyberieme zalozku Control
a v casti Bonding zvolime Clear All Bonds.

Ako dalsie musime resetovat uzly (vysielace). Uzly budeme resetovat pomocou
kombinacie tlacidiel na doske. Stlacime tlac¢idlo SW1 a drzime stlacené, pocas toho
kratko stlacime tlacidlo SW2. Zacne svietit zelena LEDka. Okamzite po jej zhasnuti
pustime tlacidlo SW1. Po tomto tkone by mal vysiela¢ zacat blikat na cerveno
priblizne na 10 sekiind, potom sa uspi.

Pre nabondovanie vysielacov ku koordinatoru sa vratime do IQRF IDE a na za-
lozke Control v casti Bonding ozna¢ime Auto address a stlacime Bond Node.
Po stlaceni sa objavi okno s nac¢itavanim, v tej chvili mame 10 sekiind na to, aby sme
stlacili SW2 na doske s vysielacom. Po tispesnom nabondovani uzla ku koordinatoru
okno s nacitavanim zmizne a v tabulke uzlov sa objavi oranzova bodka. Tento proces
resetovania a nabondovania zopakujeme pre vSetky uzly. Ak mame nabondovanych
uz viacero uzlov, prepneme sa do zalozky Map View a v hornej casti obnovime
zobrazenie. Ak je vSetko spravne, mozeme vidief schému koordindtora a ku nemu

nabondovanych uzlov.

Téato schéma sice obsahuje koordinator a uzly avsak neobsahuje zatial cesty a spo-
jenia medzi jednotlivymi bodmi siete, preto je potrebné spustit proces s nazvom dis-
covery, ktory priradi jednotlivé uzly do zén a prideli im virtudlne smerovacie ¢isla.
Pre simuléciu redlneho stavu umiestnime niektoré uzly do vzdialenejsej polohy alebo
mozeme pouzif tieniaci obal. Na zalozke Control v sekcii bonding znizime TX po-

wer na 1, taktiez z dévodu zhorsenia parametrov siete. Teraz spustime vyhladavaci
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algoritmus tlac¢idlom Discovery. Nésledne sa v karte Map View po aktualizovani
zobrazia aj cesty medzi uzlami a vytvoria sa takzvané zény, ktoré znazornuju logické
usporiadanie siete z pohladu koordinatora. Spravnost vykonania akcie discovery mo-
zeme taktiez overit tak, ze v zalozke Control zmodreji bodky znazornujice jednotlivé
uzly vid. B.5

V zalozke Table View sa teraz nachadza tabulka s jednotlivymi bodmi nasej
siete, s jej parametrami ako je napriklad RSSI (Receive Signal Strenght Indication)
udéavajuci silu prijatého signalu. Pre nazorni ukazku funkcénosti mesh siete teraz
umiestnime vysielace do roznej vzdialenosti a znova vykoname proces discovery.
V karte Map View je teraz dostupna nova topoldgia IQRF mesh siete. Funkcénost
komunikécie medzi vysielacom a uzlami overime tak, ze zasleme na jednotlivé vy-
sielace spravy, ktoré vykonaji nami zvoleni akciu (vypni-zapni LED). Pravym tla-
¢idlom klikneme na riadok s danym vysielacom a v menu zvolime LED on. Této

sprava sa prenesie siefou a na urcéenom vysielaci rozsvieti LED.

~ Nodes Info

Bonded Modes: 3  <1,3>

Discovered Nodes: 3 <1,3>
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Obr. A.5: Sekcia Nodes info
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A.4.3 Bonusova uloha

Upravte program ExternaTeplotaTXRPPico.py tak, aby bolo mozné posielat tep-

loty pod nulou s presnostou na jedno desatinné miesto. Zaroven teplotu upravte tak,

aby sa uSetrilo ¢o najviac prenasanych dat.

Néapoveda: pre odosielanie teploty pouzite 3 bajty a offset teploty.

Takto upravena sprava je v technologiach IoT CastejSie vyuzivana, pretoze Setri po-

¢et vysielanych bajtov, ¢o méa za nasledok skratenie casu potrebného pre odoslanie.

Ak vysielac vysiela kratsie, tak dochadza ku vyraznej Gspore spotrebovanej energie,

¢o je velmi dolezity faktor pre zariadenia napajané z batérie.

A.4.4 Pouzité prvky na pracovisku

PC s IQRF ID a progamom Thonny

BPC - 10T - doska

Teplotné ¢idlo AHT20

Koordindtor GW-USB-06

Vysiela¢ IQRF TR-72DA 3ks

Programovacia doska CK-USB-04a

Aplikacnéa doska DK-EVAL-04a 2ks

Prepojovacie kable USB A do USB C a USB A do mikroUSB
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B Laboratory task IQRF module for measu-
ring of mesh networks

B.1 Measurement Objective

The objective of the laboratory task is to familiarize students with the basic functions
and possibilities of IQRF IoT technology, understand the mesh topology and the prin-

ciples of communication between devices within it.

B.2 Assighment

o Familiarize yourself with the devices in the workplace.

o Create a simple Point to Point communication between the coordinator and
the transmitter. In this simple network, program the available Raspberry Pi
Pico microcontroller to transmit temperature information from the node to
the coordinator.

o Create a network with a mesh topology containing a coordinator and two no-
des, and familiarize yourself with the impact of changing the position of a node

on the transmitting signal and the mesh network topology.

B.3 Theoretical Introduction

IQRF (Intelligent Quick Response Frequency) is a wireless technology and plat-
form for IoT that is packet-oriented. It allows the transmission of small amounts
of data with minimal power consumption and maximum reliability. The technology
is suitable for demanding applications that require the lowest possible power con-
sumption, such as battery-powered installations, IoT applications, smart cities and
buildings.

IQRF technology operates in the unlicensed Sub-GHz ISM (industrial scientific
medical) radio bands (433, 868, 915 MHz), depending on the continent or country
of installation. In the Czech Republic, the 868 MHz band is used. IQRF technology
modules can operate in various topologies, such as point-to-point, star, but most
commonly, it is used in mesh topology. Figure B.1 shows a typical design of an IQRF
network containing individual nodes (sensors) in a mesh topology, a gateway, cloud,

and an internet connection (application for communication with the outside world).
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IQRF MESH
Traneei Network
@K GATEWAY APLICATION
=

Obr. B.1: Structure of IQRF network

The maximum range of a single IQRF transmitter is certified at 500 m in open
space, which when using more than 200 devices in a mesh topology, can cover an area
of up to tens of square kilometers. For this reason, the IQRF network is classified as
a WMAN (Wireless Metropolitan Area Network). Figure B.2 compares the range of
an IQRF network with the ranges of other IoT networks.

IQMESH (Intelligent Mesh) is a patented mesh communication protocol used
within the IQRF technology ecosystem. It is designed to facilitate wireless commu-
nication in a mesh topology, where each device can communicate with surrounding
devices and potentially serve as a relay node to extend the network’s range. Each
packet is routed through the nodes without restricting their functionality. This pro-
cess is managed by the operating system and is transparent to the user. IQMESH
supports various routing structures such as full mesh, reduced mesh, optimized mesh,
tree, etc. Routing can be static and can also be under the complete control of the
user. Dynamic timing with a selection of the number of hops in the network and an
optional time slot allows for maximum throughput with minimal interference and
power consumption. Efficiency and reliability are achieved through a so-called flo-
oding mechanism, which works similarly to a flood - the information is sent to the
destination through multiple possible paths, similar to how water in a flood inunda-
tes areas it can flow through. Collisions in the network are prevented using a Time

Division Multiple Access system, which means multiple access with time division.

86



WPAN

@ Wi-Fi, Bluetooth, ZigBee

(7 Wireless M-Bus, Wi-Fi {2) () 1aRF| LoRa, sigFox

b 8%
_/

R

10-100 m

100 - 1000 m—

1-10 km—>|

10 - 100 km—>

Obr. B.2: Comparison of the range of various networks in the IoT sector

Other technical details of IQRF network are in table Tab. B.1

IQRF
Parameter Unit Value
Operating frequency MHz | 433, 868, 916
Data rate kbps 20
Max. message lenght byte 64
Max. range in open space m 1000
Modulation - GFSK
Topology - mesh
Latency ms 60 - 100
Max. numberof nodes per gateway - 65103
Theoretical lifetime on AAA battery | year 5-10

Tab. B.1: Summary of IQRF network parameters

B.4 Procedure for Measurement

First, check the setup of the workstation according to the block diagram in Figure
B.3 and verify the position of the jumpers. The first should be set for 3.3 V logic,

and the second should enable the mini PCle card.
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IQRF OD @O IQRF
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Obr. B.3: Block diagram of the workstation setup

B.4.1 Point to point Communication

Before creating point-to-point communication, it is necessary to create and upload
a program in microPython language to the BPC-IoT board. This program will re-
ceive the temperature from the temperature sensor via the 12C bus, process it, and
according to the IQRF SPI guide, create a packet that is received by the IQRF
transmitter.

Launch the IQRF IDE program and create a new project: New -> Non-
networking Demo -> Next. Name the project and click Next. Set the TR
Module to TR-72Dx and keep the IQRF OS on the latest version: Finish -> Yes
to All. Add demo code parts to the newly created project - right-click on the Pro-
ject tab on the left side of the screen and select Source -> Add -> FExisting
Item...-> ExternaTeplotaTXIQRF.c -> Open for the transmission part, and
for the reception part, right-click Source -> Add -> New Non-networking
Example.... In the newly opened window, select E02-example of simple RF
receiving. Choose and confirm the demo code. -> Next -> Finish -> Yes ->
Yes to All. The Source tab should now contain the code parts (ExternaTeplotaT-
XIQRF.c and E02-RX.c); if not, repeat the procedure.

Once the demo projects are created, we need to generate output HEX files that
can be uploaded to the individual devices. Highlight the first project ExternaTeplo-
taTXIQRF.c with a circle and press the green cube (B.4 - 1) at the top of the
screen. The Output HEX tab (below Source) will show the created Hex File named
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after the source (TeplotaTX.hex). Similarly, create a HEX file for the second part
E02-RX.c (E02-RX.hex).

For proper network function (even Point to Point), both devices must be set to
the same frequency band. Therefore, double-click the TR configuration tab and
set the RF band to 868 MHz, RF channel A to 67, and RF channel B to 62. Confirm
your configuration with the Close -> Yes -> Sawve button. This configuration

will appear in the TR configuration tab on the left side of the screen.

The created output HEX files and TR configuration can be uploaded to the
individual devices. Connect the USB coordinator to the computer, and a flashing
green circle labeled GW-USB-06 will appear in the lower left corner of the screen. If
not, check if IQRF IDE is open in multiple windows or reconnect the programmed
device. Once the green circle is flashing, everything is ready to upload the program.
Upload the receiving part of the project to the coordinator by selecting E02-RX.hex
in the Output HEX tab and your created configuration in the TR configuration tab.
Then press the microcontroller button with a blue checkmark (B.4 - 2) at
the top of the screen. A confirmation message about the successful program upload
to GW-USB-06 will appear at the bottom of the screen

To upload the transmission part of the program, first insert the red transmitter
into the SIM slot on the programmer (module with gray base) and connect it to
the computer using a USB cable. Then, in the lower part of the screen, right-click
on the flashing green circle and select the second device (CK-USB -04A). In the
Output HEX tab, select TeplotaTX.hex and upload the program to the second device
using the microcontroller button with a blue checkmark (B.4 - 2). Another
confirmation message will appear at the bottom of the screen. Insert the programmed
transmitter back into the BPC-IoT board. This program receives the temperature
via the SPI bus, checks its correctness, and sends it to the IQRF coordinator. Verify
the correctness of the received message in the Terminal Log section at the bottom

of the screen.

Debug USB Device Tools Window Help

V. a A&

' Terminal Log a
View: | |UseWumbers [ Auto Scroll

Obr. B.4: IQRF IDE for better navigation
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B.4.2 IQRF Mesh Network

To create a new mesh network, you first need to ensure that the network elements
(coordinator and nodes) are not already paired with other elements. Therefore, reset

the pairing settings for the coordinator first, then for the nodes.

We start by adding Plugins to the project, which will need to be uploaded to
the coordinator and the nodes. Right-click on the Project -> Plug-ins -> Add
-> DPA Plug-in... tab, in the newly opened window, check DPA-Coordinator-
SPI-7xD... and DPA-Node-STD-7xD..., and confirm the selection by clicking OK.
When uploading to individual devices, ensure that only the Plugin tabs specific
to the coordinator or node are checked, and in the TR Configuration tab, use the
configuration from the previous exercise. In the same way as in the previous part,
upload both the Plugin and the configuration to the coordinator and the nodes. In
this case, it is not necessary to create HEX files.

Once the coordinator and node are successfully programmed, you can begin
resetting previous pairing information. To reset the coordinator, connect it to the
computer first. Then select the IQMESH Network Manager tab at the bottom
of the screen, select the Control tab in it, and in the Bonding section, choose Clear
All Bonds.

Next, we need to reset the nodes (transmitters). The nodes will be reset using
a combination of buttons on the board. Press and hold the SW1 button, then briefly
press the SW2 button while still holding SW1. The green LED will light up. Release
SW1 immediately after the green LED turns off. After this operation, the transmitter
should start flashing red for about 10 seconds before going to sleep.

To bond the transmitters to the coordinator, return to IQRF IDE and, in the
Control tab, in the Bonding section, check Auto address and press Bond Node.
After pressing, a loading window will appear; at this moment, you have 10 seconds
to press SW2 on the transmitter board. Upon successful bonding of the node to the
coordinator, the loading window will disappear, and an orange dot will appear in the
node table. Repeat this process of resetting and bonding for all nodes. If multiple
nodes are bonded, switch to the Map View tab and refresh the view at the top.
If everything is correct, you will see a diagram of the coordinator and the bonded

nodes.

This diagram contains the coordinator and nodes but does not yet show the paths
and connections between the network points, so it is necessary to run a process call-
ed discovery. This process assigns the nodes to zones and gives them virtual routing
numbers. To simulate a real situation, place some nodes in distant locations or use
a shielding cover. In the Control tab, under bonding, reduce the TX power to 1 to

worsen the network parameters. Now run the discovery algorithm by clicking Dis-
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covery. Subsequently, in the Map View tab, after updating, paths between nodes
will be displayed, creating so-called zones that represent the logical arrangement of
the network from the coordinator’s perspective. The success of the discovery action
can also be verified by the blue dots representing the individual nodes turning blue
in the Control tab, see B.5.

In the Table View tab, a table now contains the individual points of our net-
work with their parameters, such as RSSI (Receive Signal Strength Indication),
indicating the strength of the received signal. For a practical demonstration of the
mesh network’s functionality, place the transmitters at various distances and perform
the discovery process again. In the Map View tab, the new topology of the IQRF
mesh network is now available. The functionality of communication between the
transmitter and nodes can be verified by sending messages to the transmitters to
perform a chosen action (turn on/off LED). Right-click on the row with the given
transmitter and select LED on from the menu. This message will be transmitted

through the network, and the LED on the specified transmitter will light up.

~ Nodes Info

Bonded Modes: 3 <1,3>

Discovered Modes: 3 <1,3>
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Obr. B.5: Section Nodes info
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B.4.3 Bonus Task

Modify the program ExternaTeplotaTXRPPico.py so that it can send temperatures
below zero with an accuracy of one decimal place. Additionally, adjust the tempe-

rature transmission to save as much data as possible.
Hint: use 3 bytes and an offset for temperature transmission.

The modified message is more commonly used in IoT technologies because it sa-
ves the number of transmitted bytes, resulting in shorter transmission times. When
the transmitter sends for a shorter duration, it leads to significant energy savings,

which is a crucial factor for battery-powered devices.

B.4.4 Components used in the workstation

o PC with IQRF IDE and Thonny program

o BPC-IoT board

o Temperature sensor AHT20

o Coordinator GW-USB-06

o IQRF TR-72DA transmitter (3 pieces)

e Programming board CK-USB-04a

» Application board DK-EVAL-04a (2 pieces)

o USB A to USB C cables and USB A to microUSB cables
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C Schéma a navrh dosky modulu
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D 3D model dosky modulu
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E Gerber data

Jednotlivé gerber subory pre vyrobu modulu, ktoré su potrebné pri zadavani objed-

navky u vyrobcu.

Obr. E.1: Top layer
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Obr. E.3: Top Solder
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Obr. E.4: Bottom Solder

Obr. E.5: Top Overlay
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Obr. E.6: Top Paste

Obr. E.7: Bottom Paste
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F Zdrojové kady

import time

import struct

from machine import SPI, Pin, I2C
from ahtx0 import AHT20

sck_pin = Pin(10, Pin.O0UT)
Pin (11, Pin.O0UT)
miso_pin Pin (12, Pin.IN)
cs_pin = Pin(13, Pin.0OUT)

mosi_pin

spi = SPI(1, baudrate=20000, polarity=0, phase=0, sck=sck_pin,
=mosi_pin, miso=miso_pin)
cs_pin.value (1)
i2¢1 = I2C(1, scl=Pin(15), sda=Pin(14), freq=100000)
tmp_sensor = AHT20(i2c1)
tmp_sensor.initialize ()
def ReadTemp ():
time.sleep (0.5)
temp = tmp_sensor.temperature
print (str(round(temp, 2)))
time.sleep (1)
return "{:.2f}".format (round (temp, 2))
def calculate_crc(hex_string):
xor_result = 0xFO - 0x85 ~ O0xb5F
for i in range(0, len(hex_string), 2):
xor_result ~“= int(hex_stringl[i:i+2], 16)
return xor_result
def SendTemp (temp):
hex_string = ’’.join(’{:02x}’.format (ord(c)) for c¢c in temp)

crc_value = calculate_crc(hex_string)
message = f’f085{hex_stringl}t{crc_value:02x}00’

byte_array = bytes.fromhex(message)
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formatted_string = ’’.join(’\\x{:02x}’.format(b) for b in

byte_array)
print (f"Formatted SPI Message: {formatted_stringl}")
spi.write(byte_array)

while True:
temp = ReadTemp ()
cs_pin.off () # Start of SPI communication

time.sleep_ms (10)

SendTemp (temp)
time.sleep_ms (10)

print (spi.read(20)) # Reading of slave answer
time.sleep_ms (10)

cs_pin.on() # End of SPI communication

Vypis F.1: Kod pre BPC-IoT dosku odosielajticu teplotu cez SPI zbernicu na IQRF

vysiela¢ (ExternaTeplotaTXRPPico.py)
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#include "IQRF.h"
void _sleepWOC(void);
void APPLICATION ()
{
enableSPI();
clrwdt ();
//infinite loop of receiving message via SPI
while (1)
{
clrwdt () ;
sleepW0OCQ);
//LED flashing if SPI bus is busy
if (getStatusSPI())

{
pulseLEDR () ;
}
else
{
if (_SPIRX) //checking if there are available data
{
if (_SPICRCok) //checking if data aren’t damaged
{

//data 5 bytes are in bufferCOM
copyBufferCOM2RF () ;
DLEN = SPIpacketLength;

RFTXpacket () ; //send message
waitDelay (25) ;
startSPI (0); //SPI released for master
}
else
{
//damaged data
bufferCOM[0] = ’C’;
bufferCOM[1] = ’R’;
bufferCOM[2] = ’C’;
bufferCOM[3] = ’> 7 ;
bufferCOM[4] = ’e’;
bufferCOM[5] = ’r’;
bufferCOM[6] = ’r’;
copyBufferCOM2RF () ;
DLEN = 7;
RFTXpacket () ; //send message
waitDelay (25) ;
startSPI (0); //SPI released for master
waitDelay (250) ;
}
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else
{ //no data message
bufferCOM[0] = ’n’;
bufferCOM[1] = ’0’;
bufferCOM[2] = > 7;
bufferCOM([3] = ’d’;
bufferCOM([4] = ’a’;
bufferCOM[5] = ’t’;
bufferCOM[6] = ’a’;
copyBufferCOM2RF () ;
DLEN = 7;
RFTXpacket () ; //send message
waitDelay (25) ;
startSPI (0); //SPI released for master again
waitDelay (250);
}

3

Vypis F.2: Kod pre vysiela¢ prijimajici data cez SPI zbernicu a posielajici ich
koordinatoru (ExternaTeplotaTXIQRF.c)
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import time

from machine import SPI

BUTO = machine.Pin(6, machine.Pin.IN)

sck_pin = machine.Pin(10, machine.Pin.0UT)
mosi_pin = machine.Pin(11, machine.Pin.Q0OUT)
miso_pin = machine.Pin(12, machine.Pin.IN)
cs_pin = machine.Pin (13, machine.Pin.QUT)

spi = SPI(1, baudrate=200000, polarity=0, phase=0, sck=sck_pin,

mosi=mosi_pin, miso=miso_pin)

while True:
BUTO_state = BUTO.value()
BUTO_pressed = not BUTO_state
print (f"Button Pin State: {BUTO_state} Button Pressed: {
BUTO_pressedl}")

if BUTO_pressed:
cs_pin.off ()
time.sleep (0.05)

cs_pin.on()

Vypis F.3: Kod pre BPC-IoT dosku, ktory odosle spravu o teplote z interného ¢idla
na IQRF vysiealéi stlacenim tlacidla BUTO (TeplotaTXRPPico.py)
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#include

!IIQ
void _sleepW

RF.h"
0C(void);

void APPLICATION ()

{
unsl6 temperature, tmp;
uns8 i, tenths;
waitMS (100);
enableSPI();
while (1)
{
if (getTemperature() != -128)
{
temperature = param3;
bufferCOM([0] = °T’;
bufferCOM[1] = ’=";
bufferCOM([2] = > 7;
bufferCOM([5] = ’.°;
bufferCOM([7] = 0xBO;
bufferCOM([8] = ’C’;
if (temperature.high8 & 0x08)
{
temperature = ~temperature;
temperature++;
bufferCOM[2] = ’-7;
}
tenths = temperature.low8 & OxOF;
temperature >>= 4;
i = temperature.low8 / 10;
bufferCOM[3] =i + ’07;
i = temperature.low8 7 10;
bufferCOM[4] = i + ’07;
tmp = tenths * 625;
i = tmp / 1000;
tmp %= 1000;
if ((tmp >= 500) && (i < 9))
i++;
bufferCOM[6] = i +°0°;
startSPI(9);
}
else
{

bufferCOM[0]

]
—
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bufferCOM[1] = -,

bufferCOM[2] = ’e’;
bufferCOM[3] = ’r’;
bufferCOM[4] = ’r’;

startSPI(5);

sleepW0OCQ);
startSPI(1);

if (buttonPressed)

{
copyBufferCOM2RF () ;
pulseLEDR () ;
PIN = 0;
DLEN = 9;
RFTXpacket () ;
waitDelay (25) ;

Vypis F.4: Kod pre vysiela¢ odosielajuci teplotu z interného ¢idla po stlaceni tlacidla

na IQRF koordindtor (TeplotaTXIQRF.c)
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import time

import struct

from machine import SPI, Pin,I2C
from ahtx0 import AHT20

#initialization of SPI bus

sck_pin = machine.Pin(10, machine.Pin.0UT)
mosi_pin = machine.Pin(11, machine.Pin.Q0OUT)
miso_pin = machine.Pin (12, machine.Pin.IN)
cs_pin = machine.Pin(13, machine.Pin.Q0UT)

spi = SPI(1, baudrate = 20000, polarity=0, phase=0, sck=sck_pin,
mosi=mosi_pin, miso=miso_pin)

cs_pin.value (1)

#initialiyation of I2C bus
i2¢1 = I2C (1, scl = Pin(15), sda = Pin(14), freq = 100000)

#initialization of temperature sensor
tmp_sensor = AHT20(i2c1)
tmp_sensor.initialize ()

temp=tmp_sensor.temperature

#function which reads temperature from sensor
def ReadTempOPT():
time.sleep (0.5)
temp=tmp_sensor.temperature
temp=(temp+40) *10 #optimalization of temperature
print ("{:d}".format (int(round(temp, 0))))
time.sleep (1)
#foramting temperature ot xxx format
return "{:d}".format (int (round(temp, 0)))

#calculation of CRC
def calculate_crc(hex_string):
# Initialize XOR with FO, 85, and 5F
xor_result = O0xFO -~ 0x83 ~ O0x5F
for i in range(0, len(hex_string), 2):
xor_result "= int(hex_stringl[i:i+2], 16)

return xor_result

#function which creates SPI packet and after that packet is send
def SendTemp (temp):
hex_string = ’’.join(’{:02x}’.format (ord(c)) for c in temp)

crc_value = calculate_crc(hex_string)

110




message = f’f083{hex_stringl}t{crc_value:02x}00’

byte_array = bytes.fromhex(message)

formatted_string = ’’.join(’\\x{:02x}’.format(b) for b in

byte_array)
print (f"Formatted SPI Message: {formatted_stringl}")

spi.write(byte_array)

while 1:
temp = ReadTempOPT ()
cs_pin.off () #start of SPI communication

time.sleep_ms (10)

SendTemp (temp)
time.sleep_ms (10)

print (spi.read (20)) #reading of slave answer

time.sleep_ms (10)

cs_pin.on() # end of SPI comunication

Vypis F.5: Program pre dosku BPC-IoT s optimalizovanym tvarom pre teplotu

(Bonus.py)
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